West Customer Service

Westlaw Technical and Search Assistance (available 24 hours a day)
If you have general or technical questions about Westlaw, call West Customer Technical Support at 1-800-888-9907 or send an e-mail message to west.support@thomsonreuters.com.
If you have search questions about Westlaw, call the West Reference Attorneys at 1-800-888-9907 or send an e-mail message to west.referenceattorneys@thomsonreuters.com.
Technical and search assistance is also available online at westlaw.com/customersupport.

Accessibility Support
For information on West’s accessibility policy, go to west.thomson.com/accessibility or send an e-mail message to west.accessibility@thomsonreuters.com.

Billing and Account Assistance
For billing and account assistance, call 1-800-328-4880.
Billing and account assistance is also available online at west.thomson.com/support.
To manage your Westlaw account online, click My Account at west.thomson.com/support.

Westlaw Training
For information about Web-based training, telephone training, or in-person training, visit west.thomson.com/westlaw/training.

Reference Materials
To browse and order free Westlaw reference materials, visit west.thomson.com/westlaw/guides. Westlaw and other West products also contain valuable online Help.

About This Guide
In this guide, the graphics and step-by-step instructions are based on accessing Westlaw via the Internet. Because of the evolving nature of Internet technology, there may be recent changes to the Westlaw interface and functionality that are not reflected in this documentation.

Limited Warranty
Except as expressly stated in the Westlaw software license agreement, the software is provided “as is” without warranty of any kind, express or implied, including, but not limited to, warranties of performance or merchantability or fitness for a particular purpose. User bears all risk relating to quality and performance of the software.

ALR, Black’s Law Dictionary, CJS, Federal Supplement, KeyCite, LawDesk, National Reporter System, Premise, Uniform Laws Annotated, United States Code Annotated, USCA, Westlaw, westlaw.com, West’s California Reporter, and West’s are registered trademarks of West Publishing Corporation, used herein under license.
Folio is a registered trademark of Folio Corporation.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Premise U.S. Pat. No. 5,157,783
© 2009 Thomson Reuters. All rights reserved.
West
610 Opperman Drive
Eagan, MN 55123-1396
Printed in the United States of America
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Accessing Westlaw</td>
<td>40</td>
</tr>
<tr>
<td>5</td>
<td>Printing and Downloading</td>
<td>31</td>
</tr>
<tr>
<td>6</td>
<td>Online Books</td>
<td>39</td>
</tr>
<tr>
<td>7</td>
<td>Using Westlaw Databases and Services</td>
<td>43</td>
</tr>
<tr>
<td>8</td>
<td>Searching Case Law Books</td>
<td>49</td>
</tr>
<tr>
<td>9</td>
<td>Searching Statutes and Rules Books</td>
<td>65</td>
</tr>
</tbody>
</table>

Sticky Notes .......................................................... 27
Attach Item ............................................................ 28

Using the Headings Field .............................................. 68
Using the Caption Field ................................................ 67
Using the Prelim Field .................................................. 67
Using the Citation Field ................................................ 66
Choosing Connectors ..................................................... 65

Using Field Restrictions in Your Query .............................. 50
Terms and Connectors and Fields Template Search Methods ... 55
Natural Language Search Method ........................................ 56

Choosing Connectors ..................................................... 65
Using the Citation Field .................................................. 66
Using the Prelim Field ..................................................... 67
Using the Caption Field ..................................................... 67
Using the Headings Field .................................................... 68
Using the Text Field ....................................................... 68

Accessing the Table of Contents Service .............................. 48
Accessing Dictionaries .................................................... 47

Choosing Connectors ..................................................... 65
Using the Citation Field .................................................. 66
Using the Prelim Field ..................................................... 67
Using the Caption Field ..................................................... 67
Using the Headings Field .................................................... 68
Using the Text Field ....................................................... 68
Using the Credit Field .......................................................... 69
Using the Popname Field (Available in the Index Book Only) ......................... 69
Using the Histnotes Field (Not Available in All Libraries) .................................. 69
Using the References Field (Annotated Statutes Only) ..................................... 70
Using the Annotations Field (Annotated Statutes Only) .................................. 70
Searching Statutes and Court Rules .................................................. 70
Using the Statutes Index .................................................................. 74
Searching Session Laws .................................................................. 75
Searching Court Orders .................................................................. 77

10 SEARCHING DIGEST BOOKS ................................................................81
Overview ......................................................................................... 81
Using Digest Books ........................................................................ 81
Using the Topic List ......................................................................... 82
Using Court and Publication Abbreviations .............................................. 82
Searching a Digest Book ................................................................... 83
Using Descriptive Words ................................................................... 83
Using Field Restrictions ..................................................................... 84

11 SEARCHING ADMINISTRATIVE LAW BOOKS .....................................87
Overview ......................................................................................... 87
Using Administrative Code Books ......................................................... 87
Researching Administrative Rules and Regulations ....................................... 88
Researching Administrative Decisions .................................................... 89
Updating Administrative Materials Using Westlaw ...................................... 92

12 CHANGING PREFERENCES ..............................................................93
Overview ......................................................................................... 93
Changing Preferences ........................................................................ 93
Screen Display Settings ..................................................................... 93
Changing Text Display Settings ........................................................... 94
Text Display Settings ......................................................................... 94
Changing Workstation Options ............................................................ 95
Changing Search Options ................................................................... 96
Setting Up Client Validation ................................................................ 97

13 USING THE TOOLBAR ....................................................................99
Overview ......................................................................................... 99
Customizing the Toolbar ..................................................................... 99
1 Getting Started

Overview
Premise Research Software (Premise), a software package provided by Thomson Reuters, gives you the ability to access and search material stored on compact discs. Premise was designed for use with the West CD-ROM Libraries, but it can also be used to access Westlaw.

This chapter shows you how to perform the following tasks:

- start Premise
- begin a new research session
- resume work on an existing project
- get help with Premise and your research
- exit the Premise software

Starting Premise
Click the Premise 4 icon or choose Start, Programs, West Applications, then Premise 4 to start Premise.

The Premise Welcome window allows you to quickly start your research in one of three ways:

<table>
<thead>
<tr>
<th>Click this button</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Begin work in a new project by displaying the Library.</td>
</tr>
<tr>
<td>Open</td>
<td>Resume work in an existing research project.</td>
</tr>
<tr>
<td>Install</td>
<td>Install new books from a CD-ROM disc</td>
</tr>
</tbody>
</table>

Beginning a New Project
A “project” is the umbrella within which you can perform research for a particular client or case. Each time you start new research, Premise creates a new project. Within each project, Premise maintains a complete record of your research, including every query you have run and the number of documents each query retrieved. In addition, Premise tracks how much time you have spent on each project.

When you start Premise and click New, a new project is automatically created and given a default name (e.g., Project: untitled). You can begin new research by simply selecting a book and starting your research. Select a book at the Library window by highlighting it, as shown in Figure 1 on page 2.
The following table explains terminology used with Premise and your West CD-ROM Libraries:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library or Library window</td>
<td>The Library window contains a list of the books that you have installed.</td>
</tr>
<tr>
<td>Book</td>
<td>Each title listed in the Library window is a book. You can select one or more books from the Library to search or browse.</td>
</tr>
<tr>
<td>West CD-ROM Libraries</td>
<td>West CD-ROM Libraries are collections of information produced by West that you can search using Premise. Some examples are West's California Reporter and West's Social Security Library. A West CD-ROM library may consist of several books; for example, the Arizona Reports library contains Arizona Reports and Arizona Attorney General Opinions, each of which is a separate book.</td>
</tr>
</tbody>
</table>

If the Library window is not displayed, you can display it by choosing Library from the Window menu.

**SELECTING A BOOK AND STARTING YOUR RESEARCH**

Complete the following steps to select a book and start your research:

1. In the Library window, select the title of the book you want to search.
2. You can start your research by choosing one of the following buttons in the Library window:
   - Search. Click **Search** or double-click the book title to display the Search Book dialog box for the selected book. You can enter a query in this dialog box.
• **Scope/First Page.** Click **Scope** to view the first page of the selected book, which usually contains coverage information for West CD-ROM Libraries books.

• **Document List.** Click **Doc List** to view a list of all documents included in the current book.

• **Retrieve Document.** When you know the citation of the document you want to retrieve, click **Retrieve Doc.**

### SAVING YOUR RESEARCH

1. When you have completed your research, choose **Save Project** from the File menu.

2. Type a new project name in the **Filename** text box. The filename can be up to eight characters long. If you do not specify a file extension,.prj will be used.

   The project will be saved in the path and subdirectory shown in the **Directory** field unless you specify another location. You can save the project in another location by typing it in the **Filename** text box with the project name. For example, to save a project named DAVIDSON in your network user directory, you could type `s:\user\davidson`.

   Entering information in the **Project Description** and **Client Identifier** text boxes is optional. Information you enter in these boxes will be displayed in the Project summary window for this project.

3. Click **OK**.

   Your project is still open, and the Project window's title bar displays the name you assigned to the project.

### OPENING AN EXISTING PROJECT

To open an existing research project, complete the following steps:

1. Choose **Open Project** from the File menu. The Project Summary dialog box for the current project appears. Click **OK** to close this dialog box.

2. Select a project from the **Files** list box.

3. Click **OK**.

   The Project window displays a chronological list of the steps you have taken in this project, including each activity, the book it was performed in, and the number of documents retrieved.

   You can perform any of your previous research steps again by selecting it in the list and then choosing **Go to Item**.

### VIEWING THE PROJECT SUMMARY

Choose **Project Summary** from the File menu to view the session time, total time, and total Westlaw time spent on the current project and to see the Notebook file being used for the project.

If you want to store the summary information with your project, enter a description and client ID and click **OK**. If you do not want to store the information with your project, click **Cancel**. Click **Print** to print the project summary information.

**Note** You can go to the Library window and run a new query or retrieve another document by choosing **Library** from the Window menu.
EXITING PREMISE
To close the Premise software, choose Exit Premise from the File menu.
2 Retrieving Documents by Citation or Title

Overview
One of the most valuable tools Premise provides is the ability to quickly and easily retrieve a document when you know its citation or title. This chapter shows you how to perform the following tasks:

- retrieve a case when you know its citation
- retrieve a statute when you know its citation
- retrieve a case when you know its title

Retrieving Case Law by Citation
The method you use to retrieve a case when you know a citation varies, depending on whether you are searching in a library that consists of several discs or just one disc.

SINGLE-DISC LIBRARIES
When you know the citation of a case and you have a single-disc library, use the Retrieve Document command.

2. Click Retrieve Doc in the lower right corner of the window.

The Retrieve Document dialog box is displayed.

3. Type your citation with or without spaces or periods in the Citation text box. For example, to retrieve the case cited at 821 P.2d 714, type 821p2d714.
4. Click OK.
MULTIPLE-DISC LIBRARIES
You can retrieve a document by citation from a multiple-disc library in two ways:

- If you know which disc contains your case, complete the steps listed below.
- If you are not sure which disc your case is on, complete the steps for “Retrieving Documents Using the Table of Cases Book” below.

To retrieve a specific case when you know the citation to a publication printed on the disc, complete the following steps:

1. Select the book in the Library that contains the volume number of the case you want to retrieve. For example, if you want to retrieve 112 S.Ct. 674, select Supreme Ct. Rapture, 91-116 S.Ct.
2. Click Retrieve Doc.
3. Type your citation with or without spaces or periods in the Citation text box. For example, type 112sct674.
4. Click OK.

RETRIEVING DOCUMENTS USING THE TABLE OF CASES BOOK
When you are not sure which disc contains your case, you can retrieve it by using the Retrieve Document command in the Table of Cases book.

1. Select the Table of Cases book, e.g., Supreme Court Reporter Table of Cases, from the Library.
2. Click Retrieve Doc.
   The Retrieve Document in Book dialog box is displayed.
3. Type your citation with or without spaces or periods. For example, to retrieve 59 U.S.L.W. 4519, type 59uslw4519.
4. Click OK.
5. Click the right Term arrow to go directly to your case in the list.
   The citation you searched for appears in bold red type.
6. Double-click the citation to jump directly to the case.
   **Note** You may be prompted to insert another disc.

RETRIEVING STATUTES BY CITATION
When you know the statute or rule section, article or paragraph number, you can retrieve the statute or rule by restricting your search to the citation field.

To retrieve a statute when you know the citation, complete the following steps:

1. From the Library window, select a statutes book.
2. Click Search.
   The Fields Template is displayed.
   **Note** If the Fields Template is not displayed, select Fields Template from the Search Using drop-down box.
Retrieving Documents by Citation or Title

3. Select Document List from the View Results As drop-down list to view your search result in a list. Select Document Text to view the first page of your search result.

4. Type the citation of the statute you want to retrieve in the Citation text box. For example, to retrieve Colo. Rev. Stat. Ann. § 24-80-910, type 24-80-910.

5. Click Search.

   The document list search result is displayed.

   Note To view the full text of a document in a document list search result, click View Doc.

Retrieving Case Law by Title

The method you use to retrieve a case when you know the party names varies, depending on whether you are searching in a library that consists of several discs or just one disc.

SINGLE-DISC LIBRARIES

When you know the names of the parties in a case, you can retrieve the case by running a title field search.

1. Select the book, e.g., Wisconsin Reporter, in the Library.

2. Click Search.

   The Fields Template is displayed.

   Note If the Fields Template is not displayed, select Fields Template from the Search Using drop-down list.
3. Select Document List from the View Results As drop-down list to view your search result in a list. Select Document Text to view the first page of your search result.

4. Type the names of the parties you are searching for, separated by a space, in the Fields text box. For example, to retrieve Jo Ann Allison v. Merck and Company, Inc., type allison merck.

5. Click Search.
   
   **Note** You do not need to enter the full name of each party. Do not include abbreviations such as Co., Corp. or Inc.

   The document list search result is displayed.

   **Note** To view the full text of a document in a document list search result, select it and click View Doc.

**MULTIPLE-DISC LIBRARIES**

When you know the names of the parties in a case, you can retrieve your case by running a search in the Table of Cases book and then jumping to your case from the list.

1. Select the Table of Cases book, e.g., Wisconsin Table of Cases, in the Library.
2. Click Search.

   The Fields Template is displayed.

   **Note** If the Fields Template is not displayed, select Fields Template from the Search Using drop-down list.
3. Type the names of the parties separated by a space in the Title text box. For example, to retrieve *Sands v. Morongo Unified School District*, type *sands morongo*.

4. Click **Search**.
   - **Note** You do not need to enter the full name of each party. Do not include abbreviations such as Co., Corp. or Inc.
   - If you view your result as **Document Text**, the first page of the Wisconsin Table of Cases book is displayed.
   - If you view your result as a **Document List**, a result list is displayed. Select a document from the list and click **View Doc**.

5. Click the right **Term** arrow to go directly to your case in the list.
   - The party names you searched for appear in bold red type.

6. Double-click the citation, underlined in blue type, that corresponds to your case to jump directly to the case.
   - **Note** You may be prompted to insert another disc.
3 Retrieving Documents

Overview
One of the advantages of using Premise is the ability to retrieve documents by searching for descriptive words. This chapter shows you how to perform the following tasks:

- select a book or books to search
- select an appropriate search method
- retrieve documents using a Natural Language search
- retrieve documents using a Terms and Connectors search
- restrict your search to selected sections or fields of a document by using the Fields Template

Selecting Books to Search
Premise gives you the ability to search one book or run a search across multiple books.

To select the books you want to search, complete the following steps:

1. From the Library, select the book you want to search. To select multiple books, click the first book you want to search, then hold down the Ctrl key and click each additional book title.
2. After you have selected all of the books that you want to search, click Search.
3. Enter your query in the Search Book or Search Multiple Books dialog box and click Search. During the search, you are prompted to switch discs as required.
4. After you run your query in a single book, a list of result documents is displayed. After you run your query in multiple books, the number of search results for each book is displayed.

Premise offers you a choice of search methods to make your research as accurate, efficient and complete as possible. The type of research and your knowledge of the research issue determine which method is best suited to your needs.

NATURAL LANGUAGE
The Natural Language search method allows you to retrieve documents by typing a description in plain English. Premise then displays the documents that most closely match the concepts in your description.

Because Natural Language is easy to use, you can quickly retrieve relevant documents the first time you use Premise. If you are an experienced Premise user, you can use Natural Language as an additional tool to increase the thoroughness of your research. Natural Language can be especially effective when you are dealing with complex issues.

TERMS AND CONNECTORS
When you use the Terms and Connectors search method, you enter a query that consists of key terms from your issue and connectors specifying the relationship between those terms. Use this method when you want your search terms to appear within a certain proximity of each other or you want to retrieve all cases containing your search terms.
FIELDS TEMPLATE
The documents in West CD-ROM Libraries and on Westlaw are composed of unique sections of information called fields. The Fields Template is a fill-in-the-blank template that allows you to restrict your search to certain fields, such as the title field. Unlike Terms and Connectors, you do not need to supply a connector between terms. The /p connector is automatically placed between your search terms so Premise looks for them in the same paragraph. You may use a different connector if you choose.

SEARCHING WITH NATURAL LANGUAGE
To begin a Natural Language search, complete the following steps:
1. From the Library, select the book(s) you want to search.
2. Click **Search**.

A dialog box similar to the one shown below is displayed:

![Natural Language dialog box](image)

**Note** If the Natural Language dialog box is not displayed, select **Natural Language** from the **Search Using** drop-down list.

ENTERING A DESCRIPTION AND DISPLAYING YOUR RESULT
Suppose your issue concerns whether a manufacturer must disclose the side effects of a drug. To retrieve cases discussing this issue, type a description like the following and then click **Search**:

**must a manufacturer disclose the side effects of a drug**

Premise processes your description and displays the 20 documents most closely matching the concepts in your description, beginning with the document that has the greatest likelihood of matching.

When you search using Natural Language, your documents are ranked by statistical relevance with the document most closely matching your description ranked first.
ADDING ALTERNATIVE CONCEPTS TO YOUR DESCRIPTION

You can increase the efficiency of your Natural Language search by adding alternative concepts to your description. To add alternative concepts to your description, use the Premise thesaurus or add your own concepts.

Using the Premise Thesaurus
The Premise thesaurus provides a list of concepts you can add to your description. To add related concepts to your description, complete the following steps.

1. In the Natural Language dialog box, type your description and click Thesaurus.

   A dialog box similar to the one shown below is displayed:

   ![Thesaurus dialog box](image)

   Figure 3-2. Thesaurus dialog box

2. Select the concept for which you would like to see related concepts from the Concepts that have Related Concepts list box. For example, select manufacturer to display a list of related concepts in the Related Concepts list box.

3. Select the alternative concepts that you want to add to your description from the Related Concepts list box. For example, select producer and wholesaler to add these concepts to your description.

4. The concepts are placed in parentheses and added to your description in the Current Description list box.

5. Click OK to return to the Natural Language dialog box.

Adding Your Own Alternative Concepts
Although the Premise thesaurus provides many alternatives from which to choose, it should not be substituted for your own judgment. For instance, the thesaurus does not offer terms with opposite meaning (antonyms). Therefore, if you want to add an antonym to your description, you must add it yourself. To add your own alternative concept, simply type the alternative concept in parentheses immediately following the concept to which it relates, e.g., constitutional (unconstitutional).
Creating Your Own Phrases
You can create your own phrases by enclosing the words in quotation marks (""). For example, if you would like to include the phrase law practice in your description, type “law practice.” Create your own phrases only when you are sure that you want the words to appear in the order indicated within the quotation marks.

Adding Restrictions to Your Description
You can limit your Natural Language description to a specific court, judge, attorney or date by adding a field restriction. To add a restriction to your description, complete the following steps:

1. In the Natural Language dialog box, select a restriction, e.g., Judge, in the Restrictions list box. The Field Content dialog box is displayed.
2. Type the information for which you want to restrict your search. For example, to restrict your search to cases in which Justice Souter wrote the majority opinion, type souter in the text box and click OK.

Premise retrieves the documents that satisfy your description and any restrictions you specify.

Searching with Terms and Connectors
Formulating a Terms and Connectors query is a two-step process:

1. Choose your search terms.
   • Isolate the important terms from your issue.
   • List alternative terms (synonyms and antonyms).
   • Insert root expanders and universal characters where appropriate.
2. Place connectors between the terms.

CHOOSING YOUR SEARCH TERMS
The first step in formulating a Terms and Connectors query is stating your issue and isolating the key terms. For example, suppose your issue is the statute of limitations for the fraudulent concealment of a defect or condition.

Your goal in selecting search terms is to select unique terms that describe your issue. Selecting a few unique terms more effectively narrows your search result than selecting general terms. In this example, the important terms are

• statute of limitations
• fraudulent concealment
• defect
• condition

When selecting search terms, you must take into account the various forms in which they might occur. Premise searches for some variations of terms automatically, such as plurals. In other cases, you must tell Premise to search for certain variations.
The following subsections explain in detail how Premise searches for terms.

**Compound Words**

A compound word may appear in various ways, such as hyphenated or as one word or two words. If your search term is a compound word, use its hyphenated form to retrieve all variations, such as whistle-blow!

**Acronyms**

Like compound words, acronyms appear in various ways in documents. If your search term is an acronym that may appear with or without periods, enter it with periods and no spaces, such as h.i.v.

**Plurals and Equivalencies**

Premise automatically retrieves regular and irregular plurals when you enter the singular form of a term. This capability is called the “automatic pluralizer.”

*Note* The automatic pluralizer operates only when you enter the singular form of the term. When you enter a plural form, Premise only retrieves the plural form.

Following are examples of regular and irregular plurals automatically retrieved by Premise when you enter a singular term:

<table>
<thead>
<tr>
<th>The term</th>
<th>Retrieves</th>
</tr>
</thead>
<tbody>
<tr>
<td>car</td>
<td>car, cars</td>
</tr>
<tr>
<td>bonus</td>
<td>bonus, bonuses</td>
</tr>
<tr>
<td>penny</td>
<td>penny, pennies</td>
</tr>
<tr>
<td>memorandum</td>
<td>memorandum, memoranda, memorandums</td>
</tr>
<tr>
<td>alumnus</td>
<td>alumnus, alumni</td>
</tr>
<tr>
<td>child</td>
<td>child, children</td>
</tr>
</tbody>
</table>

Premise automatically retrieves equivalencies of terms. For example, 5 and five are equivalents, as are August and Aug. This means when you search for either term, you retrieve both terms.

**Words Too Common to Search: Stop Words**

Some words, such as the or with, are too common to be searched efficiently. These terms are called stop words. If you include a stop word in your query, Premise displays the following message:

*Your query contains one or more terms that are too common to search. Please rephrase your query and try again.*

You can only use a stop word if it is embedded in a phrase search. Note, however, that the stop word is not searched; rather it acts as a placeholder for a term.
For example, if you use the stop word *without* in the phrase, any of the following might be retrieved:

<table>
<thead>
<tr>
<th>The phrase:</th>
<th>Retrieves:</th>
</tr>
</thead>
<tbody>
<tr>
<td>“judgment without prejudice”</td>
<td>judgment, without prejudice</td>
</tr>
<tr>
<td></td>
<td>judgment with prejudice</td>
</tr>
<tr>
<td></td>
<td>judgments regarding prejudice</td>
</tr>
<tr>
<td></td>
<td>judgment might prejudice</td>
</tr>
<tr>
<td></td>
<td>judgment, this prejudice</td>
</tr>
</tbody>
</table>

This query retrieves any document in which *judgment* precedes *prejudice* by two words.

**Note** Stop words cannot be the first or last word in a phrase search.

**Listing Alternative Terms (Synonyms and Antonyms)**

After choosing your primary search terms, you need to consider which alternative terms are necessary. You should consider both synonyms and antonyms.

<table>
<thead>
<tr>
<th>If your primary search term is:</th>
<th>Consider also searching for alternative terms:</th>
</tr>
</thead>
<tbody>
<tr>
<td>good faith</td>
<td>bad faith</td>
</tr>
<tr>
<td>admissible</td>
<td>inadmissible</td>
</tr>
<tr>
<td>statute of limitations</td>
<td>limitation of actions; limitation period</td>
</tr>
</tbody>
</table>

**Root Expander (!)**

To retrieve words with variant endings, place the root expander (!) at the end of a root term to retrieve all possible endings of that root. The following table shows some examples:

<table>
<thead>
<tr>
<th>The term:</th>
<th>Retrieves:</th>
<th>But not:</th>
</tr>
</thead>
<tbody>
<tr>
<td>know!</td>
<td>know, knows, known, knowing,</td>
<td>knew</td>
</tr>
<tr>
<td></td>
<td>knowingly, knowable, knowledge,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>knowledgeable</td>
<td></td>
</tr>
<tr>
<td>obey!</td>
<td>obey, obeys, obeyed</td>
<td>disobey</td>
</tr>
<tr>
<td>object!</td>
<td>object, objected, objection, objecting</td>
<td></td>
</tr>
</tbody>
</table>

The root expander does not retrieve related terms that do not begin with the root word. To search for these forms, use the universal character (*), which is described in the following section.

You can only place the root expander at the end of a term. You do not need to use the root expander to retrieve plurals or possessives, as both are retrieved automatically.
Universal Character (*)
The universal character (*) represents one character. You can place the universal character in the middle or at the end of a term, but not at the beginning of a term. When you place the universal character at the end of a term, you specify the maximum length of that term. You can also combine universal characters and the root expander in one term, such as kn*W.

Examples of using the universal character are shown below:

<table>
<thead>
<tr>
<th>The term:</th>
<th>Retrieves:</th>
<th>But not:</th>
</tr>
</thead>
<tbody>
<tr>
<td>object***</td>
<td>object, objects, objected, objection, objecting</td>
<td>objectives, objections, objectionable</td>
</tr>
<tr>
<td>feat</td>
<td>feast</td>
<td>feat</td>
</tr>
<tr>
<td>s****holder</td>
<td>shareholder, stockholder</td>
<td></td>
</tr>
<tr>
<td>kn*w</td>
<td>know, knew</td>
<td>knowledge, knows, knowingly</td>
</tr>
</tbody>
</table>

Phrases
To search for a phrase, you must place the phrase in quotation marks. For example, to search for the phrase *summary judgment*, type “*summary judgment*.” Phrase searching should only be used when you are certain that the phrase will not appear in other ways.

   **Note** You can use root expanders and universal characters, described in this section, within a phrase search. Search terms placed inside quotation marks will also retrieve their automatic equivalencies, plurals and possessives.

Choosing Connectors
Connectors are symbols you place between search terms to specify the relationship between them. For example, you can specify that terms appear in the same sentence, in the same paragraph, or within a certain number of terms of each other in retrieved documents.
When you are choosing connectors, keep in mind the types of documents you want to retrieve. By selecting appropriate connectors, you can retrieve the most relevant documents. The following chart lists the connectors you can use:

<table>
<thead>
<tr>
<th>Type of connector</th>
<th>Looks like</th>
<th>Explanation</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>or¹</td>
<td>At least one of the terms must be in the document.</td>
<td>attorney or lawyer</td>
</tr>
<tr>
<td>AND</td>
<td>&amp;, and</td>
<td>Both terms must appear in the document.</td>
<td>canal &amp; flood</td>
</tr>
<tr>
<td>Connectors</td>
<td>/p</td>
<td>Terms on either side of /p must appear in the same paragraph.</td>
<td>suppress! /p evidence</td>
</tr>
<tr>
<td></td>
<td>+p</td>
<td>Terms to the left of +p must precede terms to the right of +p in the same paragraph.</td>
<td>age +p discriminat!</td>
</tr>
<tr>
<td></td>
<td>/s</td>
<td>Terms on either side of /s must appear in the same sentence.</td>
<td>slip! /s fall!</td>
</tr>
<tr>
<td></td>
<td>+s</td>
<td>Terms to the left of +s must precede terms to the right of +s within the same sentence.</td>
<td>directed +s verdict</td>
</tr>
<tr>
<td>Numerical Connectors</td>
<td>/n</td>
<td>Terms must occur within n terms of each other (where n is a specific number).</td>
<td>john /3 davidson</td>
</tr>
<tr>
<td></td>
<td>+n</td>
<td>Terms to the left of +n must precede terms to the right of +n and be within n terms of each other (where n is a specific number).</td>
<td>249 +5 218</td>
</tr>
<tr>
<td>Phrase</td>
<td>&quot; &quot;</td>
<td>Terms must appear in the same order as they do in the quotation marks.</td>
<td>“public policy”</td>
</tr>
<tr>
<td>BUT NOT</td>
<td>%²</td>
<td>Documents containing any of the terms listed after the % are excluded.</td>
<td>warn! % danger</td>
</tr>
</tbody>
</table>

¹ With Terms and Connectors, you can use a space between terms instead of the or.
² Use the % (BUT NOT) connector with caution, as it may cause relevant documents to be excluded.
Restricting Your Search to Fields
The documents in West CD-ROM Libraries are composed of unique sections of information called fields. You can limit your Terms and Connectors search to a specific court, judge, attorney, or date by adding a field restriction. Although you are searching only a portion of the document, the entire document is retrieved for viewing. (Premise automatically searches all fields in a document when you do not use field restrictions.)

For example, to restrict your search to documents decided or issued on, before or after a certain date, or between a range of dates, type da followed by the date or date range in parentheses. Many date restriction formats are acceptable:

da(3-1-93)  da(bef 3-1-93)  da(before 1993)  da(aft 1990 and bef 1993)

Connect the date restriction to the rest of your Terms and Connectors query with an and (&) connector.

USING TERMS AND CONNECTORS
After creating a query using terms and connectors, you can type the query in the Terms and Connectors dialog box and run your search.

1. From the Library, select the book or books you want to search and click Search.

   Note If the Terms and Connectors dialog box is not displayed, select Term Search from the Search Using drop-down box.

2. Type your query in the Terms and Connectors Query text box, e.g., type

   limitation /3 statute action period /p fraud!

   Note Your search time increases with the number of root expanders and connectors you use.

3. Click Search to run your search. Premise retrieves the documents that satisfy your query.
Using Fields Template

The Fields Template is an alternative to the Terms and Connectors dialog box. The Fields Template allows you to run a query without typing connectors or field restrictions. It displays a text box for each field in the document.

To search, for example, for cases from the Supreme Court of Florida that were dismissed as moot, complete the following steps:

1. From the Library, select Florida Cases, 421-687 So.2d and click Search.

   Note If the Fields Template dialog box is not displayed, select Fields Template from the Search Using drop-down list.

2. Type dismiss! moot!, separated by a space, in the Synopsis text box.

   Select the connector from the Default Connector drop-down list. In this example, the connector is /p or same paragraph. Therefore, this query will look for dismiss! in the same paragraph as moot! in the synopsis field.

   You can also type your own connector, which is then used instead of the connector specified in the Default Connector drop-down list box.

3. Type supreme in the Court text box.

4. Click Search.

   Note The AND (&) connector is always used to connect fields. In this example, Premise will search for documents with any form of the terms dismiss and moot in the synopsis field and the term supreme in the court field.
4 Browsing Documents

Overview
This chapter explains the following features:
• browsing a document, a search result, or a full book
• browsing a multiple-book search result
• jumping to referenced information
• using the See Also command
• viewing and printing images
• using personal notations

Viewing the Document List
If you select the Document List display option in the Search dialog box and perform a search, the documents you retrieve are displayed in a list window.

The Document List window displays each document’s citation, title, and other relevant information.
The query you used to retrieve the document is also displayed at the top of the window. If you have not performed a search, the List window provides a list of all the documents in the current book.
FINDING SPECIFIC TERMS IN THE DOCUMENT LIST

You can search for a specific term or series of characters within document titles in the List window by using the Find command. Complete the following steps to use the Find command:

1. In the List window, choose Find from the Edit menu.
   
The Find dialog box is displayed:

![Find dialog box](image)

   Figure 4-2. Find dialog box

2. Type the term or series of characters you want to search for in the Find what text box, such as braverman.

You can customize your search by choosing any of the following options:

- Select the Whole Words Only check box to search for words exactly as typed (no plurals or other combinations of the words will be found).
- Select the Wrap Around check box to search all documents in the list. The search will proceed to the end of the titles in the list, and then continue through the list from the beginning.
- Select the Case Sensitive check box to require that the case (uppercase or lowercase) of the terms you are searching for exactly matches that of the terms in the list.

3. Click OK. The entry containing your terms is highlighted.

4. To move to the next occurrence of your terms, choose Find Again from the Edit menu.

Reordering the Document List

In some books, you can change the display order of listed documents. The display options vary by library. Following is an example of options that might be available:

- chronological order by court
- reverse chronological order by court
- reverse chronological order
- alphabetical order by title
- print publication
If you are doing a Natural Language search, the following options are available for reordering the Result List:

- statistical relevance
- reverse publication order

To change the order of the list, choose Reorder Documents by from the Browse menu, and then select the Order option. The result list is rearranged in the order you selected.

### Browsing Your Results

If you select the Document Text display option in the Search dialog box and perform a search or retrieve a document, your result is displayed in the Text window.

The Document Text window includes several useful features and commands for browsing your result. Following are descriptions of the ways you can browse your result.

#### Browsing by Search Term

When you perform a search, your search terms are displayed in bold red type in your search result. You can browse by search term to view only the pages of the document that contain your search terms.

To advance to the next search term in a search result, choose the right Term arrow. To view the previous term, choose the left Term arrow.

**Note** You can also view the next or previous occurrence of your search terms by choosing Next Term or Previous Term from the Browse menu.

#### Browsing the Best Portion of Your Result

The Best command displays the pages containing the portion of a document most closely matching the concepts in your Natural Language description. Click the right Best arrow to view the best section of the current or next document. Click the left Best arrow to return to previous sections with better results.

**Note** You can also view the best sections of the next or previous document by choosing Next Best Section or Previous Best Section from the Browse menu.

#### Browsing by Line

You can move line by line through the displayed document by clicking the down scroll arrow at the bottom of the vertical scroll bar or by pressing the down arrow key.

You can also move backward line by line through a document by clicking the up scroll arrow at the top of the vertical scroll bar, or by pressing the up arrow key.

#### Browsing by Screen

You can view the displayed document screen by screen by clicking above or below the scroll box in the vertical scroll bar, or by pressing the Page Up and Page Down keys.

#### Browsing by Page

You can view the next or previous book page of the displayed document by choosing Next Page or Prev Page from the Browse menu.

**Note** A book page is the page as it would appear in a print publication, such as in a West reporter. Therefore, the next book page in a case law document is the beginning of the next page in the print publication.
Complete the following steps to view a specific book page:

1. Choose **Specific Book Page** from the Browse menu.

   The Specific Book Page dialog box is displayed:

   ![Specific Book Page dialog box](image)

   Figure 4-3. Specific Book Page dialog box

2. Type the number of the specific book page you want to view. For case law books, the specific page number includes the volume number, publication abbreviation, and page number, such as 413se2d153.

3. Click **OK**.

**FINDING SPECIFIC TERMS WITHIN DOCUMENTS**

You can search for a specific term or series of characters within documents using the Find command. Complete the following steps to use the Find command:

1. Choose **Find** from the Edit menu.

   The Find dialog box is displayed:

   ![Find dialog box](image)

   Figure 4-4. Find dialog box

2. Type the term or series of characters you want to search for in the **Find what** box, for example, type **testimony**.

   Choose any of the following options for your search:

   • Select the **Whole Words Only** check box to search for words exactly as typed (no plurals or other combinations of the words will be found).

   • Select the **Wrap Around** check box to search all of the current document. The search will proceed to the end of the document, and then continue from the beginning of the document.
• Select the **Case Sensitive** check box to require that the case (uppercase or lowercase) of the terms you are searching for exactly matches that of the terms in the document.

• Select the **Across Documents** check box to search all documents in your result or book.

3. Click **OK**. The first occurrence of your search terms is highlighted.

4. To move to the next occurrence of your search terms, choose **Find Again** from the Edit menu.

**Browsing by Document**

To view the next document in a search result, click the right **Doc** button at the bottom of the Text window. To view the previous document, click the left **Doc** button.

You can also browse the next or previous document by choosing **Next Document** or **Previous Document** from the Browse menu.

**Browsing All the Documents in a Book**

You can view all of the documents in a book even if they were not retrieved by your search. To do this, you must first display a Text window. Then choose **All Documents** from the Browse menu. All the documents are displayed beginning with the document you are viewing.

To return to your search result, close the window or choose your search result from the Window menu.

**Moving to a Specific Document**

You can move to a specific document in a search result or in a full book by selecting it from the Document List window. Complete the following steps to move to a specific document:

1. Click **Doc List**.
   
   The Document List window is displayed. It lists all documents that satisfy your query or are included in the current book.

2. Scroll through the list until you reach the document you want to view. With the desired document highlighted, click **View Doc**.

**Browsing Between Books in a Multiple-Book Search Result**

After performing a multiple-book search, a summary of your search results is displayed in the Multi-Book Search window. This window lists each book you searched and the number of documents in each book that satisfied your query. You can select a book and then view either a list of documents or the full text of the first document that satisfied your query.

To view a list of result documents for a particular book, select the book from the Multi-Book Search window and click **Doc List**.

To view the full text of the first result document for a particular book, select the book from the Multi-Book Search window and click **View Doc**.

To return to the Multi-Book Search window, click **MBS Summary** or choose **Multi-Book Search Summary** from the Browse menu.

The Project window allows you to see a list of the results for each book you searched. The Project window shows you how many documents were retrieved in each book. You can easily view the result of a specific book now, or run the search again in any of the books during a future session by choosing the result and then choosing **Go to Item**.
Jumping to Referenced Information
When you are viewing a document, you can use hypertext references to quickly jump to any referenced information. For example, you can jump to the text of a cited case or to the relevant portion of an opinion from a headnote.

You can jump to referenced information by double-clicking the jump marker next to the hypertext reference or any of the reference text. By default, the hypertext references appear underlined in blue type. You can change the font and color of your hypertext references in Preferences.

If you are jumping to a cited document, the referenced document’s first page is displayed. If the document is contained on a different disc, you are prompted to insert the correct disc.

When you are finished viewing the referenced information, you can return to your original location by closing the window.

Using the See Also Command
Choose See Also from the Browse menu to view additional material that is not explicitly referenced in the displayed document but is related to it, such as a pocket part document. Additionally, the See Also command allows you to move to a specific portion of a document. For example, when viewing a statute, use the See Also command to view historical notes or notes of decisions.

This command is only active when See Also material is available for the document.

Making Personal Notations
Personal notations allow you to add your own annotations to your CD-ROM research. There are four types of personal notations available in Premise:

- bookmarks
- sticky notes
- highlighting
- attachments

Note In a few situations, the notations that you add will not be positioned correctly after you install a new update CD-ROM disc. This occurs because Premise does not reposition your personal notations within data that shifts significantly. Text you annotated may have shifted within the document, causing your notations to be misplaced.

Note Personal notations are not available for research you perform on Westlaw through Premise.

BOOKMARKS
Use the Bookmark feature to mark an important location in a document for later reference.

ADDING A BOOKMARK
To add a bookmark to your document, complete the following steps:

1. Place the cursor in your document where you want to add a bookmark.
2. Choose Bookmark from the Notations menu or click the Bookmark button on the toolbar.
3. Type a bookmark name in the Enter a Bookmark Name text box, for example, breach of warranty.
4. Click Save. A bookmark icon is inserted in the text.
Going to Bookmarks
To return to the place in a document where you added a bookmark, complete the following steps:
1. Choose **Go To Bookmark** from the Notations menu.
2. Type the first few letters of the bookmark name in the first text box.
3. Select the bookmark name in the second text box.
4. Click **Go To**. The document page containing the bookmark is displayed.

Deleting a Bookmark
To delete a bookmark, complete the following steps:
1. Click the bookmark icon in the text that you want to delete. The Edit Bookmark dialog box is displayed.
2. Click **Delete**.

**STICKY NOTES**
Use the Sticky Note feature for adding your own notes while you are working within a document.

Adding a Sticky Note
Complete the following steps to create a sticky note:
1. Place the cursor in the document where you want the sticky note to display.
2. Choose **Sticky Note-Yellow** from the Notations menu or click the **Sticky Note** button on the toolbar.
3. You can also click the right mouse button to display the Notations menu.
4. Type your notes in the sticky note.
5. Click the close box in the upper right corner of the sticky note to close it. A sticky note icon is displayed in the text.

Opening a Sticky Note
If you are browsing a document and want to read an attached sticky note, click the sticky note icon to open it.

Deleting a Sticky Note
Click the Sticky Note icon in the text that you want to delete, and then choose **Delete Notation** from the Notations menu.

Highlight Pen
Use the highlight pen feature to mark important text for later reference, just as you would use a highlighting marker to accent a paper document.

Highlighting Selected Text
1. Select the text you want to highlight.
2. Choose **Highlight Selected Text** from the Notations menu.
Highlighting Large Text Areas
1. Choose Highlight Pen-Yellow from the Notations menu or click the Highlight button on the toolbar.
   
   Your cursor changes to a roller, indicating that the highlight pen is turned on.
2. Move the roller over the text you want to highlight.
   
   **Note** While the highlight pen is on, you can scroll through a document and select additional text you want to highlight.
3. To turn off the highlight pen, press the Esc key.

Going to Highlighted Text
To view a particular section that has been highlighted, complete the following steps:
1. Choose Notation List from the Notations menu.
2. Select the notation with the highlighted text you want to view.
3. Click Go To Item to jump to the section of your document containing the highlighted text.

Removing Highlighting From Text
Select the text that you want to remove highlighting from, and then choose Delete Notation from the Notations menu.

**ATTACH ITEM**
Use the Attach Item feature for attaching a non-Premise file, such as a spreadsheet or word-processing document, to a document in a Premise book.

Attaching a File or Application
To attach a document to your book text, complete the following steps:
1. Place the cursor in your document where you want to attach a document.
2. Choose Attach Item from the Notations menu.
   
   The Attach Item dialog box is displayed.
3. Select the file you want to attach and click OK.
   
   The Attach item icon is displayed in the text.

Launching an Attached File or Application
To open an attached file or application, complete the following steps:
1. Click the Attach item icon.
2. Click Yes to open the attachment.
3. If a program is not associated with the attached item file, you are asked to select the application to open it with.

Removing an Attached Item
To remove an attached item, follow these steps:
1. Choose Notation List from the Notations menu.
2. Select the notation with the attached item you want to delete.
3. Click **Delete Item**.

Setting the Location of Notation Files
Choose **Set Notation Path** from the Notations menu to set the path where the Notations files are stored.

**Note** If a public directory on a local area network is selected, everyone set to that directory will view and create notations using the public notations file. If a specific user directory is selected, the notations are specific to the user.

Selecting Labels and Colors for Your Notations
Premise allows you to categorize your notations by assigning labels and colors to them. You can arrange labels by project, priority, or any variable you choose. For example, you can assign a label and color for all your notations about a particular research assignment.

To categorize your notations by name and color, complete the following steps:

1. Click **Add** to create a new label.
2. Enter a label name in the **Please Enter a New Label** text box and click **OK**.
   
   The Select Label dialog box is displayed again.
3. Select a label color from the **Label Color** drop-down list box.
4. Click **OK** to save your label and color.

Editing a Label
To edit a label, complete the following steps:

1. Choose **Select Label/Color** from the Notations menu.
2. Select the label in the **Label** list box and click **Edit**.
3. Enter a label name in the **Change Label To** text box and click **OK**.
   
   The Select Label dialog box is displayed again.
4. Select a label color from the **Label Color** drop-down list box.
5. Click **OK** to save your label and color.

Removing a Label
To remove a label, complete the following steps:

1. Choose **Select Label/Color** from the Notations menu.
2. Select the label in the **Label** list box and click **Remove**.
3. Click **Yes** to delete the label.
4. Click **OK** to close the dialog box.
5  Printing and Downloading

Overview
This chapter explains the following features:
• printing a document or list
• downloading a document or list
• copying and pasting text
• using the Notebook
The information you can print or download (e.g., selected text or a complete document) depends on whether you are viewing document text or a list.

Printing a Document or a List
The Print command on the File menu allows you to print information from Premise and your installed books. Your printing options vary depending on whether you are viewing a list or a document when you choose the Print command.

Printing a Document
When you are viewing one or more documents in the Text window, you can print any of the following:
• selected text
• the displayed document
• selected pages of the document

Note   You can print multiple documents from the List window.

You can also select any of the following options for printing:
• dual column or book-style printing, as in a West reporter page
• full justification or single-column printing, as in statutes documents
• printing your personal notations
• printing your search terms in bold type
• printing the banner page
• printing inline images
• printing status flags
Complete the following steps to print any of the previously listed items from the Text window:

1. Choose **Print** from the File menu or click the **Print** button on the toolbar.

   The Print dialog box is displayed, as shown below:

   ![Print dialog box](image)

   **Figure 5-1. Print dialog box**

2. Select the information you want to print, e.g., selected text, a full document, or a range of pages, by selecting the appropriate button in the **Print** box.

3. Select your printing options in the **Options** box. Following are examples of printing options:
   - To print a full document in dual-column format, select **Document** and **Dual Column**.
   - To print a document in single-column format, select **Document** and **Full Justification**. This option is useful for printing statutes documents.
   - To print a document with personal notations in dual-column format, select **Document**, **Dual Column**, and **Personal Notations**.
   - To print selected pages of a document in dual-column format with the search terms in bold type, select **Pages** (type in the page numbers), **Dual Column**, and **Bold Query Terms**.
   - To print a document with the banner or copyright page and inline images, select **Document**, **Banner Page**, and **Inline Images**.

   **Note** The **Selected Text** option is only available after you have highlighted text in the document that you want to print. Full-justification printing is the only printing choice available when printing selected text.

4. Type your name in the **Requestor** text box and select **Banner Page** in the Printing Options if you want your name to appear on the printout.

5. Click **OK**.
PRINTING A LIST OR MULTIPLE DOCUMENTS

When you are viewing the Document List window or the Library, you can print any of the following:

- the entire list of document titles and citations, or the list of book titles
- selected documents

Complete the following steps to print any of the above items:

1. Choose **Print** from the File menu.

   The Print dialog box is displayed, as shown below:

   ![Print dialog box](image)

   **Figure 5-2. Print dialog box**

2. Select the information you want to print by clicking the corresponding options.

   - **Note** The *Selected Documents* option is only available when you are viewing a list of documents at the List window and you have highlighted the document titles that you want to print. The following table describes how to select multiple documents in the List window:

     | To Select                      | Do This                                                                                                                                 |
     |--------------------------------|-----------------------------------------------------------------------------------------------------------------------------------------|
     | Multiple documents             | Click the first document title that you want to print, then hold down the Ctrl key and click the title of each additional document you want to print. |
     | Multiple contiguous documents  | Click the first document title that you want to print, then hold down the Shift key and click the last document title you want to print.     |
     | All documents in the list      | Choose **Select All** from the Edit menu.                                                                                               |

3. Select your printing options by clicking the corresponding check boxes in the *Printing Options* box.
Following are examples of printing options:

- To print selected documents in dual-column format, click *Selected Document(s)* and *Dual Column*.
- To print selected documents in single-column format, click *Selected Document(s)* and *Full Justification*. This option is useful for printing statutes documents.
- To print selected documents with personal notations in dual-column format, click *Selected Document(s)*, *Dual Column*, and *Personal Notations*.
- To print selected documents in dual-column format with the search terms in bold type, click *Selected Documents*, *Dual Column*, and *Bold Query Terms*.
- To print selected documents with the banner or copyright page and inline images, select *Selected Documents*, *Banner Page*, and *Inline Images*.

**Note** Full–justification printing is the only printing choice available when printing a document list.

4. Type your name in the *Requestor* list box and select *Banner Page* in the Printing Options if you want your name to appear on the printout.

5. Click OK.

**VIEWING AND PRINTING IMAGES**

Some libraries have books that contain graphics or forms. These images can be viewed and printed from your document.

You can print images in portrait and landscape format, as well as in color.

Complete the following steps to print the inline image.

1. Choose *Print* from the File menu.

The Print dialog box is displayed:

![Print dialog box](image)

*Figure 5-3. Print dialog box*
2. Select Inline Images from the Options box.
3. Click OK to print the document with the image.

**Downloading a Document or a List**

Premise enables you to download information to either a floppy disk or a hard disk drive. Your downloading options vary depending on whether you are viewing a list or a document when you choose the Download command from the File menu.

**DOWNLOADING A DOCUMENT**

When you are viewing one or more documents in the Text window, you can download either of the following:

- all pages of the document
- selected pages of the document

You can also select any of the following options for downloading:

- dual-column or book-style format, as in a West reporter page
- full justification or single-column format, as in statutes documents
- downloading your personal notations
- downloading your search terms in bold type
- downloading the banner page

Complete the following steps to download any of the previously listed items from the Text window:

1. Choose Download from the File menu or click the Download button on the toolbar.
2. In the Pages box, click All to download the entire document, or click Pages and enter the range of pages you want to download.
3. Select your download options in the Options box by clicking the corresponding check box(es).
4. Select your downloading format in the Download Format drop-down list box.
   
   **Note**  
   Dual-column format is not available for ASCII text.
5. Type your name in the Requestor text box and select Banner Page in the Options box if you want your name to appear on the downloaded document.
6. Type a filename in the Filename text box, or select an existing file from the Files list box. Select the directory in the Directories list box in which you want to store your download information.
7. Click OK.
   
   The information is downloaded in the selected format to the directory you specified.
DOWNLOADING A LIST OR MULTIPLE DOCUMENTS

When you are viewing book or document lists in the List window or the Library, you can download either of the following:

- the entire list of titles and citations
- selected items (available from the List window only)

Complete the following steps to download either of the above items:

1. If you are downloading selected items, choose the items from the List window. The following table describes how to select multiple documents from the List window:

<table>
<thead>
<tr>
<th>To select:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple documents</td>
<td>Click the first document title that you want to print, then hold down the Ctrl key and click the title of each additional document you want to print.</td>
</tr>
<tr>
<td>Multiple contiguous</td>
<td>Click the first document title that you want to print, then hold down the Shift key and click the last document title you want to print.</td>
</tr>
<tr>
<td>documents</td>
<td></td>
</tr>
<tr>
<td>All documents in the list</td>
<td>Choose Select All from the Edit menu.</td>
</tr>
</tbody>
</table>

2. Choose Download from the File menu or click the Download button on the toolbar.

3. In the Items box, click Entire List or Selected Document(s).

4. Select your downloading options in the Options box.

5. Select your download format from the Download Format drop-down list.

6. Type your name in the Requestor text box and select Banner Page in the Options box if you want your name to appear on the downloaded document.

7. Type a filename in the Filename text box or select an existing file from the Files list box.

8. Select the directory in the Directories list box in which you want to store your downloaded information.

9. Click OK.

The information is downloaded in the selected format to the directory you specified.

USING THE NOTEBOOK

You can use the Notebook in Premise when you need a text-processing function that is not provided by using the bookmark, sticky notes, or highlight features. For example, if you are researching a complex statutory issue, instead of trying to keep track of a series of randomly scattered electronic or handwritten notes, you could use the Notebook to organize many applicable statutory sections.

The Notebook launches your word processor, allowing you to cut and paste text from a book to a new or existing word-processing document. And you can also add your own notes anywhere within the word-processing document.
The following steps explain how to use the Notebook feature:

1. Highlight the text you want to add to the Notebook and choose Copy or Copy with Reference (to copy selected text with reference information such as the document name, title and current page number) from the Edit menu.
   
   **Note** You can choose Show Clipboard from the Edit menu to view the text that you have selected to copy.

2. Choose Notebook from the Edit menu.
3. Select a file format.
4. Type a filename in the Filename text box.
5. Click OK. The Notebook file is automatically associated with the project.
6. Paste or add text to the Notebook.
7. Save the file and close the Notebook. The next time you choose Notebook from the Edit menu, the Notebook file will automatically open.

   **Note** Once you have created a Notebook file, choose Change Notebook from the Edit menu to add a new Notebook file or to select a different Notebook file to display for your project.
6 Online Books

Overview
This chapter describes the following Westlaw features:

- online update books
- transactional and hourly billing
- Westlaw connection time information

Accessing an Online Book
Some libraries have access to online update books. You do not have to install an online book separately; if access to online books is included in your library, the books are installed when you install the CD-ROM disc. The online books appear in the Library with your other books, and the source is displayed as Westlaw. Premise provides direct access to westlaw.com. Online update books contain the most current documents available on Westlaw for the related CD-ROM book.

To access an online book, complete the following steps:

1. Select an online book from the Library.
2. Click Search at the bottom of the Library window.
   The Sign On window is displayed.
3. Type your Westlaw password in the Westlaw Password text box. For security purposes, your password is not displayed as you type it.
4. Type a client identifier in the Client ID text box. This identifies your research and is required to access Westlaw.
5. Click Sign On.

Your connection to the online book is initiated. After the connection is made, Premise displays the Search dialog box.

ALTERNATIVE METHODS TO ACCESS ONLINE UPDATE BOOKS
If your CD-ROM book has a corresponding online update book, you can also search the update book using one of the following methods:

- Select the Also Search Update Book check box in the lower right portion of the Search dialog box. This option allows you to run a search across both the CD-ROM book selected for the search and the corresponding online update book.

Note The Also Search Update Book check box only appears when you are searching a CD-ROM book for which an online update book is available. The Also Search Update Book check box is only available in Terms and Connectors and Fields Template searching.
• After running a search in a CD-ROM book, click **Online Update** in the Document List or Document Text window. This option runs your previous query in the online update book and displays the result.

Both of these methods allows you to search an update book directly instead of going back to the Library window and selecting an online update book.

If you jump from an online update book to a document in another Westlaw database, you will be billed at normal Westlaw rates.

**Field Differences**

Some fields included in your CD-ROM books are not available in online update books. For example, if you are updating a statute by accessing session laws through an online update book, you cannot use the headings field in your search. Instead, simply run your search without a field restriction or use another field.

Suppose you ran the following search in your CD-ROM statutes book: *he(student & default)*. Run the following search in the session law update book using the caption (ca) and summary (su) fields: *ca,su(student & default)*.

**Accessing Westlaw**

Premise provides direct access to Westlaw.

Depending on what you want to accomplish, you will access either a database or a service. Use a Westlaw database to run a general search on Westlaw. Use Westlaw services to perform a variety of tasks. For example, to retrieve a case or statute when you know the citation, use Find.

A subscription is necessary to access Westlaw and Westlaw charges apply.

**SWITCHING BETWEEN TRANSACTIONAL AND HOURLY PRICING ON WESTLAW**

To make the most cost-effective use of your research time on Westlaw, you may choose either transactional or hourly pricing. With transactional pricing, you incur a predictable charge for each search you run with no connect time or communications charges. Hourly pricing has been the standard method of Westlaw billing. You have the flexibility to choose either pricing option and to move from one option to the other, as your needs dictate.

**CHANGING YOUR WESTLAW PRICING METHOD**

You can choose either hourly or transactional as your preferred pricing method, or you can be prompted to select a pricing method each time you access Westlaw. To select a pricing method, complete these steps:

1. Click Preferences. The Locations & Pricing Preferences page is displayed.
2. Select a pricing method from the *Searching* drop-down list: **By the Hour**, **By Transaction**, or **Ask at Sign On**.
TIPS FOR CHOOSING A PRICING METHOD

There are no hard and fast rules for choosing a pricing method, but the following lists may help you determine your needs.

Use transactional pricing when

• you plan to read and analyze documents online.
• you anticipate retrieving many relevant documents with a single search.
• you are performing multiple tasks with other software (i.e., copying text from a Westlaw document and pasting it into a brief).
• you want to perform research at a predictable cost.
• you want to browse the Westlaw Directory or Scope.

Use hourly pricing when

• you want to look at a complex issue from a number of different angles.
• numerous sources of information are needed.
• you want to quickly scan some documents in term mode to determine their relevance, and then print the citation list of documents or the documents themselves for later review.
• you need to check many citations in one or more citator services.
• you plan to retrieve many documents by citation or title.

TRANSACTIONAL PRICING GUIDELINES

Non-Chargeable Transactions

You will not incur transaction charges for using the following databases, services or commands:

• Westlaw Directory
• Scope
• Documentation and training databases (e.g., IDEN, NEW, PASSWORD)
• Locate requests
• Find requests that do not retrieve documents
• Table of Contents service
• Dictionary services
• Next document or previous document
• Sign-on processing
• Sign-off processing

Chargeable Transactions

The following requests are considered chargeable transactions:

• Running or modifying Natural Language, Terms and Connectors, or Fields Template searches
• Retrieving documents using Find
• Retrieving documents using Jump
• Running a search that retrieves no documents
• Interrupting a search after it has begun running
• Citator service requests

**Viewing Connect Time and Transactions**
To end your Westlaw research session, click **Sign Off** at the top of any Westlaw page. Your connect time and the number of transactions you completed are displayed. If you exit Westlaw by closing your browser, your connect time and number of transactions will not be available until you receive your bill.

**DISCONNECTING FROM AN ONLINE BOOK OR WESTLAW**
Click **Sign Off** from any Westlaw page. You are automatically disconnected from Westlaw when there is no keyboard activity for several minutes.
7 Using Westlaw Databases and Services

Overview
This chapter describes the Westlaw databases and services that are available on Westlaw via Premise.

Retrieving a Document on Westlaw
Premise gives you the ability to use Westlaw to retrieve documents that are not included in your library. Find on Westlaw is a service that allows you to retrieve a document simply by entering its citation. A Westlaw subscription is necessary to access the service and Westlaw charges apply.

To use Find on Westlaw, complete the following steps:
1. Choose Find on Westlaw from the Westlaw menu in Premise.
2. If you are not already connected to Westlaw, type your Westlaw password and a client identifier on the Westlaw sign-on page. Click Sign On. Your connection to Westlaw is initiated.
3. Once you are connected to Westlaw, the Find a Document page is displayed.
   1. Type the citation of the document you want to retrieve, e.g., 115sct2510, in the Find this document by citation text box.
   2. Click Go.
   3. Click Sign Off at the top of any Westlaw page.

Accessing the Westlaw Directory
You can access the Westlaw Directory through Premise to find a Westlaw database. A Westlaw subscription is necessary to access the service, and Westlaw charges apply. To access the Westlaw Directory, complete the following steps:
2. If you are not already connected to Westlaw, type your Westlaw password and a client identifier on the Westlaw sign-on page. Click Sign On. Your connection to Westlaw is initiated.
3. Once you are connected to Westlaw, the Westlaw Directory is displayed.
   1. To browse the Westlaw Directory, double-click the directory you want to view subdirectories for, e.g., U.S. Federal Materials. Choose subdirectories until the database identifier you want is displayed.
      Note Click All Databases to return to the main Westlaw Directory of databases and services.
   2. Click Sign Off at the top of any Westlaw page.
Accessing a Westlaw Database

You can access a Westlaw database directly through Premise if you know the database identifier. A Westlaw subscription is necessary to access the database, and Westlaw charges apply. To access a specific Westlaw database, complete the following steps:

1. Choose **Search Database** from the Westlaw menu in Premise.
2. If you are not already connected to Westlaw, type your Westlaw password and a client identifier on the Westlaw sign-on page. Click **Sign On**. Your connection to Westlaw is initiated.

Once you are connected to Westlaw, the Welcome to Westlaw page is displayed.

![Welcome to Westlaw page](image)

**Using KeyCite**

KeyCite is the powerful citation research service available exclusively on Westlaw.

You can use KeyCite to determine whether a case, statute, regulation, or administrative decision is good law. You can also use KeyCite to retrieve citing references to the document, including cases, administrative materials, secondary sources, and briefs and other court documents.

**ACCESSING KEYCITE**

You can access KeyCite from the Westlaw menu in Premise, or you can jump directly to the service from a case on Westlaw. A Westlaw subscription is necessary to access the service and Westlaw charges apply.

A KeyCite status flag lets you immediately know the status of a case, statute section, regulation, or administrative decision.

**KEYCITE FOR CASES**

KeyCite Status Flags

- A red flag warns that the case is no longer good law for at least one of the points of law it contains.
- A yellow flag warns that the case has some negative history but has not been reversed or overruled.
• A blue H indicates that the case has some history.
• A green C indicates that the case has citing references but no direct history or negative citing references.

KeyCite History for a Case
To view the history of a displayed case, click the KeyCite status flag or Full History on the Links tab. The case history is displayed in the right frame. To view the direct history of the case in an easy-to-read graphical view, click Direct History (Graphical View).

Figure 7-2. KeyCite history for a case

KeyCite Citing References for a Case
To view a list of cases, administrative materials, secondary sources, and briefs and other documents that cite your case, click Citing References on the Links tab. Negative citing cases are listed first; the remaining cases are listed according to depth of treatment they give your case. Click Limit KeyCite Display at the bottom of the KeyCite citing references result to limit your list of citing references.

KEYCITE FOR STATUTES
KeyCite Status Flags
• A red flag warns that the statute has been amended by a recent session law, repealed, superseded, or held unconstitutional or preempted in whole or in part.
• A yellow flag warns that the statute has been renumbered or transferred by a recent session law; that an uncodified session law or proposed legislation affecting the statute is available (statutes merely referenced, i.e., mentioned, are not marked with a yellow flag); that the statute was limited on constitutional or preemption grounds or its validity was otherwise called into doubt; or that a prior version of the statute received negative judicial treatment.
• A green C indicates that the statute has citing references.
KeyCite History for a Statute
Click a KeyCite status flag or History on the Links tab to view the history of a displayed statute. Statute history includes citations to cases affecting the validity of the statute, recent session laws that amend or repeal the section, proposed legislation, bill drafts, reports and related materials, credits, and historical and statutory notes.

KeyCite Citing References for a Statute
To view a list of documents that cite your statute, click Citing References on the Links tab. Citing references include cases that have affected the validity of the section, cases from USCA and state statute notes of decisions, cases on Westlaw that are not included in notes of decisions, administrative decisions, Federal Register documents, secondary sources, briefs and other court documents, statutes and court rules, and administrative codes.

USING THE TABLE OF AUTHORITIES
Whereas KeyCite lists citing cases (other cases that cite your case), the Table of Authorities (TOA) service lists cited cases (other cases cited by your case). The Table of Authorities is a useful tool for finding hidden weaknesses in a case by showing whether the cases on which it relies have significant negative history.

To access the Table of Authorities from Premise, choose Table of Authorities from the Westlaw menu in Premise. A Westlaw subscription is necessary to access the service and Westlaw charges apply.
To access the Table of Authorities while viewing a case in Westlaw, click Table of Authorities.

The Table of Authorities
- lists each document cited by a case. To view the full text of a cited case in the Link Viewer, click the number next to its title.
- displays depth of treatment stars for each cited case, which indicate the extent to which the citing case discusses the cited case.
- displays KeyCite status flags for cited cases.
- displays quotation marks when the citing case directly quotes the cited case.

Using the Custom Digest (Key Number) Service to Retrieve Cases
Every legal issue in a case published by West is identified and summarized in a headnote. Each headnote is then classified under one or more topics and key numbers. The complete topic and key number outline used by West attorney-editors to classify headnotes is available in Westlaw in the Custom Digest service. You can use the Custom Digest to find topic and key numbers related to your issue and to retrieve cases with headnotes classified under those topic and key numbers. To use the Custom Digest, complete these steps:
1. Click Key Numbers at the top of any page and then click West Key Number Digest Outline.
2. Click the plus (+) and minus (-) symbols to browse the outline.
3. Select the check box next to each topic or key number you want to include in your search, then click Search selected. The Custom Digest search page is displayed. The topic and key numbers you selected are listed in the Your digest selection(s) box.
4. If desired, select a different jurisdiction (your home jurisdiction is selected by default), a date restriction, add search terms, or change the order in which cases in your custom digest are displayed (the default is reverse chronological order).

5. Click **Search**. A list of all topic and key numbers included in your custom digest is displayed in the left frame. The headnotes classified under the first topic and key number in the list are displayed in the right frame.

**ACCESSING DICTIONARIES**

You can access two dictionaries on Westlaw through Premise: *Black’s Law Dictionary* and *West’s Tax Law Dictionary*. A Westlaw subscription is necessary to access these dictionaries, and Westlaw charges apply.

**Using Black’s Law Dictionary on Westlaw**

Black’s Law Dictionary gives you quick access to definitions of legal terms.

1. Choose **Dictionaries, Black’s Law Dictionary** from the Westlaw menu in Premise.
2. Type the legal term or phrase for which you want to retrieve the *Black’s Law Dictionary* definition, e.g., *covenant*.
3. Click **OK**.
   
   **Note** If you are not already connected to Westlaw, the Sign On to Westlaw page is displayed. Type your Westlaw password in the *Westlaw Password* text box. For security purposes, your password is not displayed as you type it. Type a client identifier in the *Client ID* text box.

Your connection to Westlaw is initiated. After the connection is made, Westlaw displays your *Black’s Law Dictionary* result.

**Using West’s Tax Law Dictionary on Westlaw**

*West’s Tax Law Dictionary* contains definitions of tax terms and phrases. This service contains citations to primary and related code and regulation services prepared by West editors.

1. Choose **Dictionaries, West’s Tax Law Dictionary** from the Westlaw menu in Premise.
2. Type the legal term or phrase for which you want to retrieve the *West’s Tax Law Dictionary* definition, e.g., *earned income*.
3. Click **OK**.
   
   **Note** If you are not already connected to Westlaw, the Sign On to Westlaw page is displayed. Type your Westlaw password in the *Westlaw Password* text box. For security purposes, your password is not displayed as you type it. Type a client identifier in the *Client ID* text box.

Your connection to Westlaw is initiated. After the connection is made, Westlaw displays your *West’s Tax Law Dictionary* result.
ACCESSING THE TABLE OF CONTENTS SERVICE

The Table of Contents (TOC) service on Westlaw contains the tables of contents for publications such as *Code of Federal Regulations* (CFR); *United States Code Annotated* (USCA); *Uniform Laws Annotated*; and state statutes, court rules and administrative materials. Using the Table of Contents service, you can view a document in the context of the sections surrounding it and retrieve related sections.

A Westlaw subscription is necessary to access the Table of Contents service on Westlaw, and Westlaw charges apply.

Complete the following steps to access the online Table of Contents:

1. Choose **Table of Contents** from the Westlaw menu in Premise.
2. Type the publication abbreviation for which you want to view the Table of Contents, e.g., **usca**.
3. Click **Go**.

   **Note** If you are not already connected to Westlaw, the Sign On to Westlaw page in Westlaw is displayed. Type your Westlaw password in the Westlaw password text box. For security purposes, your password is not displayed as you type it. Type a client identifier in the Client ID text box.
8 Searching Case Law Books

Overview
This chapter describes how to retrieve case law from the West CD-ROM Libraries using Premise. Specifically, the following topics are explained:

• searching by topic and key number
• using field restrictions in your query
• searching for references to cases and statutes
• adding an added-date restriction to your query

Searching by Topic and Key Number
Every legal issue in a case published by West is identified and summarized in a headnote. Each headnote is then classified under one or more topics and key numbers. The complete topic and key number outline used by West attorney-editors to classify headnotes is available in Westlaw in the Custom Digest (Key Number) service. You can use the Custom Digest to find topic and key numbers related to your issue and to retrieve cases with headnotes classified under those topic and key numbers.

Searching by topic and key number is a good way to focus your case law research on a particular legal issue. You can find useful topic and key numbers; West’s digests; and relevant cases on CD-ROM, in print or on Westlaw. The complete topic and key number analysis is available in digest books on CD-ROM.

To perform a topic and key number search in any case law book, complete the following steps:

1. Select a case law book from the Library in Premise.
2. Click Search.
   The Search dialog box is displayed.
3. To search, for example, for topic 110, Criminal Law, and key number 338(2), Admissibility of circumstantial evidence, follow the steps corresponding to your preferred search method.

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the topic number, followed by the letter k and the key number, e.g., 110k338(2).</td>
<td>In the All Fields text box, enter the topic number, followed by the letter k and the key number, e.g., 110k338(2).</td>
</tr>
</tbody>
</table>

4. Click Search.
The table below shows some examples of how to build topic and key number queries:

<table>
<thead>
<tr>
<th>Topic number</th>
<th>k</th>
<th>Key number</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>k</td>
<td>338(2)</td>
<td>110k338(2)</td>
</tr>
<tr>
<td>343</td>
<td>k</td>
<td>426</td>
<td>343k426</td>
</tr>
</tbody>
</table>

**USING FIELD RESTRICTIONS IN YOUR QUERY**

You can limit your search to the most pertinent part of a document by using a field restriction. Although you are searching only a portion of the document, the entire document is retrieved for viewing. (Premise automatically searches all fields in a document when you do not use field restrictions.)

To run a query using field restrictions, complete the following steps:

1. Select a case law book from the Library and then click **Search**.
2. Follow the steps corresponding to your preferred search method:

   **Terms and Connectors**
   - Type the abbreviation for the field restriction, followed by your search terms and connectors in parentheses.

   **Fields Template**
   - Type your search terms in the appropriate field text box. Use the scroll bar to display additional fields.

3. Click **Search**.

The fields available in your case law books are listed below.

<table>
<thead>
<tr>
<th>Field*</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citation</td>
<td>ci</td>
<td>Unique references for citing specific documents</td>
</tr>
<tr>
<td>Title</td>
<td>ti</td>
<td>Names of the parties</td>
</tr>
<tr>
<td>Synopsis</td>
<td>sy</td>
<td>Opinion summary</td>
</tr>
<tr>
<td>Topic</td>
<td>to</td>
<td>Topic and key number</td>
</tr>
<tr>
<td>Headnote</td>
<td>he</td>
<td>West-prepared summary of a single point of law</td>
</tr>
<tr>
<td>Digest</td>
<td>di</td>
<td>Topic, court and headnotes</td>
</tr>
<tr>
<td>Court</td>
<td>co</td>
<td>Court</td>
</tr>
<tr>
<td>Date</td>
<td>da</td>
<td>Date of decision</td>
</tr>
<tr>
<td>Judge</td>
<td>ju</td>
<td>Judge authoring lead opinion</td>
</tr>
<tr>
<td>Attorney</td>
<td>at</td>
<td>Names of counsel</td>
</tr>
<tr>
<td>Text</td>
<td>op</td>
<td>Text of opinion</td>
</tr>
</tbody>
</table>

* The default connector is /p. To use a different connector, either type it in your query or choose one from the Default Connector drop-down list box.
* For Fields Template searching, click the scroll bar to view all fields.
Using the Citation Field
Restrict your search to the citation field (ci) when you want to retrieve the case itself. Searches restricted to the citation field will not retrieve cases referring to the case.

Note The most efficient way to retrieve a case when you know its citation is to use the Retrieve Document feature.

For example, to retrieve 368 Mass. 447, follow the format corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>ci(368 +5 447).</td>
<td>In the Citation text box, type 368 447.</td>
</tr>
</tbody>
</table>

When you are using the Terms and Connectors method, use the +5 connector rather than the publication abbreviation between the volume and page number because there are often several publication abbreviations possible. You could use a more restrictive connector than +5 (e.g., +2 or +3); however, using a more restrictive connector may cause you to miss documents whose publication abbreviation exceeds two or three terms.

Using the Title Field
Restrict your search to the title field (ti) when you do not know the citation of the case but you do know the party names. Include only significant terms from the title, rather than the entire title.

For example, to retrieve the case State ex rel. Elvis Presley International Memorial Foundation v. Crowell, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>ti(presley &amp; crowell).</td>
<td>In the Title text box, type presley crowell.</td>
</tr>
</tbody>
</table>

If you know only a portion of the title or if the parties have common names, combine one party's name with terms that are descriptive of the case. The following query retrieves cases with Griffin in the title that contain the phrase Sherman Act anywhere in the document:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>ti(griffin) &amp; “sherman act”.</td>
<td>In the All Fields text box, type “sherman act” Then in the Title text box, type griffin.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

* This query uses the default /p connector. Different fields are automatically connected with the & connector.
Using the Synopsis Field
The synopsis is a brief description of a case that is prepared by editors at West. Most synopses are composed of four parts:

- a review of the facts presented in the case
- the lower court judge’s name and holding
- the holding of the court in the case
- dissenting or concurring judges’ names

Cases decided before 1963 may not contain synopses with all of the above information.

Restricting your search to the synopsis field (sy) allows you to retrieve cases such as the following:

- cases in which a particular judge has authored a concurring or dissenting opinion
- cases in which a specific judge has been reversed or affirmed on appeal
- cases in which the court has taken a certain procedural action, such as vacating a case
- Appellate cases in which a particular lower court judge has authored an opinion on a specific issue

Concurring Opinions
To retrieve cases containing concurring opinions filed by a particular judge, search in the synopsis field for the judge’s name and the term concur!

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Synopsis text box, type</td>
</tr>
<tr>
<td>sy(farley +s concur!)</td>
<td>farley +s concur!.</td>
</tr>
</tbody>
</table>

This search retrieves cases in which Farley precedes concur or any form of concur, such as concurs, concurred, and concurring, within the same sentence and all within the synopsis field.

Dissenting Opinions
To retrieve cases containing dissenting opinions filed by a particular judge, search in the synopsis field for the judge’s name and the term dissent!

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Synopsis text box, type</td>
</tr>
<tr>
<td>sy(atkins +s dissent!)</td>
<td>atkins +s dissent!</td>
</tr>
</tbody>
</table>

This search retrieves cases in which Atkins precedes dissent, dissented, or dissenting, within the same sentence and all within the synopsis field.
**Reversed Judgments**

To retrieve cases in which a particular judge has been reversed in whole or in part by an appellate court, search in the synopsis field for the judge’s name and the term *reversed*.

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Synopsis text box, type fahey &amp; reversed.</td>
</tr>
</tbody>
</table>

This search retrieves cases in which the name *Fahey* and *reversed* appear in the synopsis field. It is possible that this search will also retrieve cases in which Fahey was not the lower court judge. To eliminate irrelevant cases, you need to review the search result.

**Affirmed Judgments**

To retrieve cases in which a particular judge has been affirmed in whole or in part by an appellate court, search in the synopsis field for the judge’s name and the term *affirmed*.

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Synopsis text box, type fahey &amp; affirmed.</td>
</tr>
</tbody>
</table>

This search retrieves cases in which the name *Fahey* and *affirmed* appear in the synopsis field.

**Using the Digest Field**

The digest field (di) contains the following information for all digest paragraphs in a case:

- topic and key number classification hierarchy
- court
- headnote text

The digest field is useful when your query contains common or frequently used words. By limiting your search to the succinct statement of law contained in the digest, you eliminate extraneous references to your search terms.

For example, hundreds of cases involving air pollution or air quality briefly discuss the issue of standing somewhere in their opinions. To retrieve only cases in which the legal question of standing is an issue, limit your search to the digest field.

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Digest text box, type standing air quality or pollut!.</td>
</tr>
<tr>
<td>di(standing /p air /p quality or pollut!).</td>
<td></td>
</tr>
</tbody>
</table>

Digest paragraphs on CD-ROMs differ slightly from those displayed in a West reporter. When viewing a headnote on a CD-ROM, you can see the complete hierarchy of concepts that were used to classify the point of law to a specific key number. This information allows you to quickly see the precise legal issues addressed in the case.

* This query uses the default /p connector.
Using the Topic Field
The topic field (to) is part of the digest field. The topic field contains the following West digest topic information for each topic in a case:

- topic name (e.g., Workers Compensation)
- topic number (e.g., 413)
- key number
- key number classification hierarchy
- former key number (if any)

Use the topic field when you want to retrieve all cases classified under a particular West topic number. For example, the number 110 is the numerical designation for the topic Criminal Law. You can retrieve all cases classified under this topic by entering one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Topic text box, type</td>
</tr>
<tr>
<td>to(criminal /5 law).</td>
<td>criminal /5 law.</td>
</tr>
<tr>
<td>Type the query</td>
<td>In the Topic text box, type</td>
</tr>
<tr>
<td>to(110).</td>
<td>110.</td>
</tr>
</tbody>
</table>

Using the Headnote Field
The headnote field (he) is part of the digest field. Each headnote contains a West-prepared summary of a single point of law discussed in the opinion.

The headnote field does not include the topic number, digest classification information, key number or court.

For searching purposes, all of the headnotes in a case are considered to be in the same field. Therefore, if you restrict your search to the headnote field and use the & connector, you may retrieve cases containing terms in different headnotes. Instead, use the /p connector to search for terms in the same headnote.

A headnote field restriction is useful when you are researching an issue with common terms or when you are searching for cases citing non-unique statute or rule numbers.

For example, to retrieve U.S. courts of appeals cases discussing the statute of limitations and 42 U.S.C.A. § 1983, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Headnote text box, type</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.
Using a Court Restriction

Use the court field (co) to limit your CD-ROM search result to decisions from a particular jurisdiction. For example, you can limit your search to cases decided by the supreme court of a state by using the following restriction:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query co(supreme).</td>
<td>Scroll to the Court text box and type supreme.</td>
</tr>
</tbody>
</table>

To restrict your search to a specific court, such as the Ohio Court of Common Pleas, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query co(&quot;common pleas&quot;).</td>
<td>Scroll to the Court text box and type &quot;common pleas&quot;.</td>
</tr>
</tbody>
</table>

Using a Date Restriction

Use a date restriction (da) when you want to limit your search to cases decided on a specific day, month or year or within a range of dates. Double-click DA in the Restrictions list box to display the Date Restriction dialog box. The Date Restriction dialog box allows you to easily enter the dates to which you want to restrict your search. Because many libraries are already divided into ranges of years by the different books, you may not need to restrict your query to a range of years.

**TERMS AND CONNECTORS AND FIELDS TEMPLATE SEARCH METHODS**

The following table lists examples of date restriction formats using the Terms and Connectors and Fields Template search methods:

<table>
<thead>
<tr>
<th>To restrict your search to:</th>
<th>Type your Terms and Connectors* query and add:</th>
<th>In the Fields Template Date text box, type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A day</td>
<td>&amp; da(7/24/1985)</td>
<td>7/24/1985</td>
</tr>
<tr>
<td>After a given date</td>
<td>&amp; da(aft 1997)</td>
<td>aft 1997</td>
</tr>
</tbody>
</table>

* Connect a date restriction to a Terms & Connectors query using the & connector.
NATURAL LANGUAGE SEARCH METHOD

To add a date restriction to a Natural Language search, complete the following steps:

1. Double-click **Date** in the **Restrictions** list box.

The Date Restriction dialog box is displayed:

2. Select the type of date restriction you want. Depending on the type of restriction you select, one or both of the date fields become active.

3. Enter your dates in the text boxes.

4. Click **OK** after entering your date restriction.

Figure 8-1. Date Restriction dialog box

- Select the type of date restriction you want. Depending on the type of restriction you select, one or both of the date fields become active.
- Enter your dates in the text boxes.
- Click **OK** after entering your date restriction.
The following table lists examples of date restriction formats using Natural Language:

<table>
<thead>
<tr>
<th>To restrict your Natural Language search to:</th>
<th>In the Date Restriction dialog box, select this option:</th>
<th>Then type this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A day</td>
<td>A Specific Date</td>
<td>In the Date text box, type 7 10 1994.</td>
</tr>
<tr>
<td>A month</td>
<td>A Specific Date</td>
<td>In the Date text box, type 10 1994.</td>
</tr>
<tr>
<td>A year</td>
<td>A Specific Date</td>
<td>In the Date text box, type 1994.</td>
</tr>
<tr>
<td>Before a given date</td>
<td>Before a Specific Date</td>
<td>In the Before text box, type 5 1995.</td>
</tr>
<tr>
<td>After a given date</td>
<td>After a Specific Date</td>
<td>In the After text box, type 7 10 1994.</td>
</tr>
<tr>
<td>Between dates</td>
<td>Between Two Dates</td>
<td>In the After text box, type 11 21 1993</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the Before text box, type 3 1994.</td>
</tr>
</tbody>
</table>

**Using the Judge Field**

Use the judge field (ju) to limit your search to full-text decisions in which a particular judge authored the majority opinion.

For example, to find all of the majority opinions authored by a judge named Fitzgerald, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>Scroll to the Judge text box and type fitzgerald.</td>
</tr>
<tr>
<td>ju(fitzgerald)</td>
<td></td>
</tr>
</tbody>
</table>

**Note**  A judge field search does not retrieve an opinion in which a judge dissented or concurred.
Using the Attorney Field

The attorney field (at) contains the names of attorneys who represented the parties or who were involved in argument of the case on appeal. It may also contain the name of the attorney’s firm and the city where the firm is located. Search for the attorney’s last name. If the last name is common, include the first name.

**Note** Not all decisions include the attorney's first name; therefore, searching for only the last name gives you the most complete results.

For example, to find reported cases in which Alan Dershowitz represented a party, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query at(dershowitz).</td>
<td>Scroll to the Attorney text box and type dershowitz.</td>
</tr>
</tbody>
</table>

To find reported cases in which Louise O'Neil represented a party, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query at(louise /3 o'neil).</td>
<td>Scroll to the Attorney text box and type louise o’neil.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

Using the Text Field

The text field (te) contains the text of the opinion as written by the judge. This field contains the following information:

- majority opinion written by the judge
- court and docket information
- names of counsel representing parties
- names of the judges participating in the decision
- concurring and dissenting opinions

Circumstances in which you would limit your search to the text field are rare. This is because the text field is so broad that it does not add to the precision of your search as other fields do. Additionally, by limiting your search to the text field, you exclude valuable information contained in the editorially prepared digest and synopsis fields. The digest and synopsis fields contain additional terms that help you retrieve more relevant documents.
Searching for References to Cases and Statutes

You can retrieve cases in your case law libraries that cite or refer to a particular authority (e.g., case law, statutes, regulations, rules). When you search for documents that cite your document, you are using Premise as a citator.

SEARCHING FOR REFERENCES TO CASE LAW

To retrieve documents that cite a particular case, search for the case's citation or title, or both. Because you do not want to retrieve the cited case, but rather documents that cite it, do not restrict your search to the citation or title fields; search the entire document for references to the case.

Titles

To retrieve documents citing a particular case by searching for the case's title, substitute the /s connector for the v. in the case title, and search only for the names of the major parties.

For example, to retrieve cases that cite *Pennzoil Co. v. Texaco, Inc.*, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>pennzoil /s texaco.</td>
<td>pennzoil /s texaco.</td>
</tr>
</tbody>
</table>

There is no solid rule for which connector to use. The /s connector is recommended over a numerical connector because it is difficult to predict how a title will be cited in another case.

If a case has a lengthy title, search for unique terms from the title rather than for the entire title. Note that certain words may be abbreviated (e.g., *U.S.* may appear instead of *United States*). In those instances, search for both the abbreviated and unabbreviated forms of the term, as in this example:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>mistretta /s u.s. or “united states”.</td>
<td>mistretta /s u.s. or “united states”.</td>
</tr>
</tbody>
</table>

Leave out abbreviations such as *Corp.*, *Co.* or *Inc.* For example, to retrieve cases citing *Mitsubishi Motors Corp. v. Soler Chrysler-Plymouth, Inc.*, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>mitsubishi /s soler.</td>
<td>mitsubishi /s soler.</td>
</tr>
</tbody>
</table>
You also can search for references to a case within the context of a specific fact pattern. Use the &
connector to connect the terms describing the fact pattern to the rest of your query. For example, to
retrieve cases discussing Muniz v. Hoffman and the right to a jury trial on contempt charges, enter one
of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>muniz /s hoffman &amp; contempt /p jury.</td>
<td>muniz /s hoffman &amp; contempt /p jury.</td>
</tr>
</tbody>
</table>

**Citations**

You can also retrieve citing documents by searching for the case’s citation. This technique is
recommended when there is more than one action between the parties and you want to find references
to a specific decision, or when the terms in the case’s title are common.

To search for a citation, substitute a connector for the publication abbreviation; the recommended
connector is +5. For example, to retrieve documents that cite Sedima, S.P.R.L. v. Imrex Co., 473 U.S.
479, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>473 +5 479.</td>
<td>473 +5 479.</td>
</tr>
</tbody>
</table>

You also may want to include a parallel citation in the query. It can take up to two years for Supreme
Court cases to be officially reported. During those two years, documents that cite Supreme Court cases
do so with parallel citations and “---U.S.---”. If you search for only the official citation of a case, you
could miss every document that cited it in the first two years after the decision was issued.

To include all pertinent parallel citations of the case, enclose the terms from each parallel citation in
parentheses. For example, parallel citations to 473 U.S. 479 are 105 S.Ct. 3275 and 87 L.Ed.2d 346. The
following queries retrieve cases containing the primary citation or either of the parallel citations:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>(473 +5 479) or (105 +5 3275) or (87 +5 346).</td>
<td>(473 +5 479) or (105 +5 3275) or (87 +5 346).</td>
</tr>
</tbody>
</table>

You can be more specific by adding the title of the cited case to your query. Using the Sedima case, for
example, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>sedima /p (473 +5 479) or (105 +5 3275) or (87 +5 346).</td>
<td>sedima /p (473 +5 479) or (105 +5 3275) or (87 +5 346).</td>
</tr>
</tbody>
</table>
Using the Automatic Premise As a Citator Query

From a case in a CD-ROM book you can retrieve cases in the same CD-ROM book that cite the case you are viewing by using an automatic query. When you search for cases citing a specific case, you are using Premise as a citator. The automatic Premise as a citator query is indicated by a Jump marker to the left of the case’s citation at the top of the document.

To use the automatic Premise as a citator query, simply double-click the Jump marker at the top of your case. A predefined query is run in the CD-ROM book containing your case, and the search result is displayed. If you want to run the same query in additional books, select the book you want to search from the Library and click Search. The Premise as a citator query is automatically entered in the Search Book dialog box. Click Search to run the query.

Note The automatic Premise as a citator query is available only in CD-ROM books and is not available in Westlaw databases.

Using the Automatic Topic and Key Number Query

West case law CD-ROM books include automatic topic and key number queries that you can run in the same CD-ROM book simply by clicking the Jump marker to the left of a topic and key number.

To use the automatic topic and key number query, click the Jump marker to the left of the topic and key number of the relevant headnote. A topic and key number search is automatically formulated and run in that CD-ROM book.

To run the same topic and key number search in additional books, select the book you want to search from the Library and click Search. The topic and key number query is automatically entered in the Search Book dialog box. Click Search to run the query.

Searching for References to Statutes

To retrieve documents that cite a particular statute section, such as a United States Code Annotated section, search for the terms from the statute’s citation. Use the following format to search for the title and section number: title +5 section.

Note To retrieve all of the subsections of a statute, use an exclamation point (!) after the section number, e.g., 713.06! retrieves references to any subsection under section 713.06. If you did not include the!, your search would retrieve references only to the section number itself.

For example, to retrieve documents that cite 42 U.S.C.A. § 1202, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query 42 +5 1202!</td>
<td>In the All Fields text box, type 42 +5 1202!</td>
</tr>
</tbody>
</table>

Because title and section numbers are common, sometimes not all of the documents retrieved with a search such as the one above refer to a USCA section. In these instances, you may want to add descriptive words to your search:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query 42 +5 1202! /p aid! or assist!</td>
<td>In the All Fields text box, type 42 +5 1202! aid! or assist!</td>
</tr>
</tbody>
</table>
In certain legal areas such as tax, statutes are sometimes cited without a reference to the title number. Your Premise as a citator query should then include alternatives to the title number, such as the term sec and the abbreviation i.r.c. For example, to retrieve cases citing 26 U.S.C.A. § 61, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>26 or sec or i.r.c. or code +5 61.</td>
<td>26 or sec or i.r.c. or code +5 61.</td>
</tr>
</tbody>
</table>

You do not need to include both sec and section in the query because they are automatically equivalent terms.

If you are searching for cases citing a specific subsection of a state or federal statute, consider all possible forms the reference might take. Subsections are cited in various ways. For example, if you search for 803(8)(b), you will miss documents that refer to 803(8) subsection b. To retrieve alternatives to 803(8)(b), use this query format:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>803(8)(b) or 803(8)b or (803(8) +5 b) or (803 +5 (8)(b)).</td>
<td>803(8)(b) or 803(8)b or (803(8) +5 b) or (803 +5 (8)(b)).</td>
</tr>
</tbody>
</table>

This query retrieves the following possibilities:

- 803(8)(b)
- 803(8)b
- any reference to 803(8) that precedes, within five or fewer terms, subsection b
- any reference to 803 that precedes, within five or fewer terms, subsection (8)(b)
The following list provides suggestions for retrieving documents that contain references to some commonly cited authorities other than statutes and cases:

<table>
<thead>
<tr>
<th>Publication</th>
<th>To retrieve cases that cite:</th>
<th>Terms and Connectors example:</th>
<th>Fields Template example*:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Register</td>
<td>58 F.R. 55021</td>
<td>58 +5 55021</td>
<td>58 +5 55021</td>
</tr>
<tr>
<td>CFR</td>
<td>24 C.F.R. 3280.813</td>
<td>24 +5 3280.813</td>
<td>24 +5 3280.813</td>
</tr>
<tr>
<td>CJS</td>
<td>49 C.J.S. Judgments § 585</td>
<td>49 +s 585</td>
<td>49 +s 585</td>
</tr>
<tr>
<td>Hornbook</td>
<td>Prosser on Torts § 42</td>
<td>prosser +10 torts / 9 42</td>
<td>prosser +10 torts / 9 42</td>
</tr>
<tr>
<td>Restatement</td>
<td>Restatement (Second) of Torts § 283</td>
<td>rest or restatement /5 2nd or 2d /5 torts /9 283</td>
<td>rest or restatement /5 2nd or 2d /5 torts /9 283</td>
</tr>
</tbody>
</table>

* Type these queries in the All Fields text box.

**Adding an Added Date Restriction to Your Query**

After you run a search in your CD-ROM books, you need to update your search using Westlaw to retrieve cases that have been added to Westlaw subsequent to the release of the case law library. If your case law book has a related online update book, use the online update book. If your case law book does not have a related online update book, or if you want to search additional databases, by choosing a case law database on Westlaw and adding an added date restriction to your query, you can restrict your search to the newest cases. A Westlaw subscription is necessary to access Westlaw, and Westlaw charges apply.

Complete the following steps to add an added date restriction to your query:

1. Choose **Search Database** from the Westlaw menu in Premise.
2. If you are not already connected to Westlaw, type your Westlaw password and a client identifier on the Westlaw sign-on page. Click **Sign On**. Your connection to Westlaw is initiated.

Once you are connected to Westlaw, the Westlaw Directory is displayed. Type the database name in the **Search for a database** text box and click **Go**. You can add an added date restriction to your query using one of the following search methods:

**Terms and Connectors**
Select a date restriction from the **Dates** drop-down list to add it to your search.

**Natural Language**
Select a date restriction from the **Dates** drop-down list.
9 Searching Statutes and Rules Books

Overview
This chapter explains the following topics:

- searching unannotated and annotated statutes
- narrowing your search with field restrictions
- retrieving federal and state statutes and court rules
- using the statutes index
- searching session laws
- searching court orders
- updating your results using Westlaw

Searching Unannotated and Annotated Statutes

SEARCHING UNANNOTATED STATUTES
Unannotated statutes contain the citation, prelim, caption, headings, text, and credit fields. They do not include notes of decision or historical notes. Some unannotated statutes also contain the histnotes field. If you do not know the citation or name of a statute, enter a descriptive word search including the statutory language that expresses the legal concepts you are researching.

CHOOSING CONNECTORS
If you want to retrieve documents with your terms in different fields or subsections of an unannotated statute, choose a broader connector like the & connector. If you want your search terms to appear together in one field of the statute, use narrower connectors such as /s (same sentence) or /p (same paragraph).

Searching Annotated Statutes
Annotated statutes contain references and annotations as well as the citation, prelim, caption, headings, text, credit, and histnotes fields. When you run a word search in an annotated statute, you are searching not only the language of the statute, but also the language in the annotations, references, and historical notes.

If you do not want to search the annotations, references, and historical notes, restrict your query to the headings and text fields.

CHOOSING CONNECTORS
If you want to retrieve documents with your terms in closer proximity, use more restrictive connectors, such as /p or /s. If you use the & connector, keep in mind that annotated statutes contain more fields than unannotated statutes, and your search may retrieve more documents than you want. If this occurs, use more restrictive connectors.
Using Field Restrictions in Your Query

Statutes are composed of specific parts called fields. You can limit your search to the portion of a statute with the most pertinent information by using a field restriction. The entire document, however, is retrieved for viewing. Restrict your search to a field when you already know the citation, name, chapter, or title number.

The following fields may be searched:

<table>
<thead>
<tr>
<th>Field</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citation</td>
<td>ci</td>
<td>Unique references for citing specific documents</td>
</tr>
<tr>
<td>Prelim</td>
<td>pr</td>
<td>Heading preceding caption</td>
</tr>
<tr>
<td>Caption</td>
<td>ca</td>
<td>Section number and heading</td>
</tr>
<tr>
<td>Headings</td>
<td>he</td>
<td>Combines the citation, prelim and caption fields</td>
</tr>
<tr>
<td>Text</td>
<td>te</td>
<td>Text of document</td>
</tr>
<tr>
<td>Credit</td>
<td>cr</td>
<td>Statutory credits</td>
</tr>
<tr>
<td>Popname*</td>
<td>po</td>
<td>Popular Name Table</td>
</tr>
<tr>
<td>Histnotes</td>
<td>hi</td>
<td>Historical notes</td>
</tr>
<tr>
<td>References†</td>
<td>re</td>
<td>Miscellaneous references</td>
</tr>
<tr>
<td>Annotations‡</td>
<td>an</td>
<td>Notes of decisions</td>
</tr>
<tr>
<td>Notes‡</td>
<td>no</td>
<td>Notes, references, annotations</td>
</tr>
</tbody>
</table>

*This field is available only in the Index book.
†These fields are available only in annotated statutes books.
‡This field is available only in court rules books.

USING THE CITATION FIELD

You can restrict your search to the citation field (ci) when you know the statute citation. You can also restrict your search to the citation field to retrieve all sections of a certain code, such as the Texas Civil Statutes.

Statutes are organized and numbered using several methods. To retrieve a particular statute, formulate a query using the appropriate format. There are three basic formats for statute citations:

- unique section number
- title and section number, or chapter and paragraph number
- code abbreviation and section number
Following are examples of each format:

<table>
<thead>
<tr>
<th>To retrieve:</th>
<th>Enter the query: (Terms and Connectors)</th>
<th>Enter the query: (Fields Template)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cal. Gov’t Code § 423</td>
<td>ci(govt +5 423)</td>
<td>govt +5 423</td>
</tr>
</tbody>
</table>

For state statutes that are organized by codes, retrieve all sections of a certain code by searching for the abbreviation of the code name in the citation field. For example, to retrieve all of the Texas Civil Statutes, follow the steps corresponding to your preferred search method:

**USING THE PRELIM FIELD**

The prelim field (pr) contains the superior title, subtitle, chapter, and subchapter headings of each section. It precedes the caption and text of each section. Restricting your search to the prelim field is useful when you know the number or name of the title or chapter.

For example, to retrieve Chapter 350 in Wisconsin statutes, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query pr(“chapter 350”).</td>
<td>In the Prelim text box, type “chapter 350”.</td>
</tr>
</tbody>
</table>

To retrieve all sections of the Uniform Commercial Code, enter one of these queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query pr(“commercial code”).</td>
<td>In the Prelim text box, type “commercial code”.</td>
</tr>
</tbody>
</table>

**USING THE CAPTION FIELD**

The caption field (ca) contains the section number followed by the terms that generally describe the section’s contents. This field is most useful when you know that the information you are searching for is found only in the caption.
You can restrict your search to the caption field in conjunction with the prelim field to retrieve certain types of sections under a major heading. For example, to retrieve sections in the California Code that contain definitions relating to hazardous waste, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td></td>
</tr>
<tr>
<td><code>pr(&quot;hazardous waste&quot;) &amp; ca(defin!).</code></td>
<td>In the Prelim text box, type hazardous waste. Then in the Caption text box, type defin!.</td>
</tr>
</tbody>
</table>

**USING THE HEADINGS FIELD**

The headings field (he) is a combination of the citation, prelim, and caption fields. When searching the headings field, use the & connector between terms. For example, to search for Indiana statutes regarding student loans and default, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td></td>
</tr>
<tr>
<td><code>he(student &amp; default!)</code></td>
<td>In the Headings text box, type student &amp; default!.</td>
</tr>
</tbody>
</table>

To retrieve Louisiana statutes under Title 14 concerning Mardi Gras, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td></td>
</tr>
<tr>
<td><code>he(&quot;title 14&quot; &amp; &quot;mardi gras&quot;).</code></td>
<td>In the Headings text box, type “title 14” &amp; “mardi gras”.</td>
</tr>
</tbody>
</table>

To retrieve New York insurance statutes regarding immunity and indemnification, you can enter a query using the abbreviation `ins` for the Insurance Code:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td></td>
</tr>
<tr>
<td><code>he(ins &amp; immun! &amp; indemni!).</code></td>
<td>In the Headings text box, type ins &amp; immun! &amp; indemni!.</td>
</tr>
</tbody>
</table>

**USING THE TEXT FIELD**

The text field (te) contains the text of the statute. In most cases, you will not want to restrict your search to the text field alone because it does not contain the superior headings and captions that put the statute in context.

* Different field restrictions are automatically connected with the & connector. This query also uses the default /p connector between the terms hazardous and waste.
USING THE CREDIT FIELD

The credit field (cr) provides information about the enactment and history of a statute. This information is in the form of session law numbers. Restricting a search to this field is useful when you are looking for the sections codified, amended, or repealed by a specific session law. For example, to retrieve statutes amended by Illinois Public Act 84-280, section 4, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query cr(84-280 /5 4).</td>
<td>In the Credit text box, type 84-280 /5 4.</td>
</tr>
</tbody>
</table>

* Using the /5 connector between terms makes your query more specific. To retrieve Texas statutes amended by Acts of 1957, chapter 499, section 2, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query cr(1957 /s 499 /s 2).</td>
<td>In the Credit text box, type 1957 /s 499 /s 2.</td>
</tr>
</tbody>
</table>

USING THE POPNAME FIELD (AVAILABLE IN THE INDEX BOOK ONLY)

The popname field (po) contains the Popular Name Table. Unlike other fields, the popname field is not just a portion of the document; it is an entire document. Use the popname field when searching the Index book to limit your search to the Popular Name Table.

Note  The Index book is not available in all libraries.

Restricting your search to this field is useful when you are looking for sections enacted or amended by a session law and you only know the popular name of the law.

Searching for a significant portion of the name, instead of the entire name, is usually sufficient. For example, to find where the New York Abandonment Act has been codified, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query po(abandon! /3 act).</td>
<td>In the Popname text box, type abandon! act.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

USING THE HISTNOTES FIELD (NOT AVAILABLE IN ALL LIBRARIES)

The histnotes field (hi) contains historical notes to the statute, including legislative and amendment notes and statutory notes that may contain such information as effective dates. In many states, the histnotes field also contains the statute text as it appears in the main volume, so you can compare the former and current text.

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type hi followed by your search terms in parentheses.</td>
<td>Type your search terms in the Histnotes text box.</td>
</tr>
</tbody>
</table>
USING THE REFERENCES FIELD (ANNOTATED STATUTES ONLY)
The references field (re) contains several types of references, including comments, cross-references, library references, law review references, form references and administrative code references.

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type re followed by your search terms in parentheses.</td>
<td>Type your search terms in the References text box.</td>
</tr>
</tbody>
</table>

USING THE ANNOTATIONS FIELD (ANNOTATED STATUTES ONLY)
The annotations field (an) contains notes of decisions that cite the particular statutory section you are searching. A note of decision summarizes a point of law from a court decision or an attorney general opinion. You can restrict your search to the annotations field when you want to retrieve annotations to cases that construe a specific term or issue within a statute section, title or chapter. For example, to find annotations in Washington’s criminal code that contain any form of the word entrap, search in the annotations field and the prelim field:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Annotations text box, type entrap!.</td>
</tr>
<tr>
<td>an(entrap!) &amp; pr(criminal).</td>
<td>Then in the Prelim text box, type criminal.</td>
</tr>
</tbody>
</table>

* Different field restrictions are automatically connected with the & connector.

Searching Statutes and Court Rules
Information about searching for United States Code Annotated sections or state statutes and rules when you have some information about the statute or rule you are researching is listed below.

When You Know the Citation
Restrict your search to the citation field when you know any of the following:

- the USCA title and section number
- the state statute title and section number or chapter and paragraph number
- the unique state statute section number
- the state code abbreviation and section number
- the federal or state rule abbreviation and section number

Title and Section Number
When you know the title and section number, use this format when restricting your search to the citation field: ci(ttitle number +5 section number). When you know the chapter and paragraph numbers, use the format ci(chapter number +5 paragraph number).
Following are examples of citations that use the title and section or chapter and paragraph numbers:

<table>
<thead>
<tr>
<th>To retrieve:</th>
<th>Enter the query: (Terms and Connectors)</th>
<th>Enter the query: (Fields Template)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>71 Pa. Stat. § 1005</td>
<td>ci(71 +5 1005)</td>
<td>71 1005</td>
</tr>
<tr>
<td>5 ILCS § 460/10</td>
<td>ci(5 +5 460/10)</td>
<td>5 460/10</td>
</tr>
</tbody>
</table>

* In the Fields Template, type the query in the Citation text box. These queries use the default /p connector.

**Note** Do not include subsections with the section number (e.g., search for 741.1005, not 741.1005(d)). To view a subsection, retrieve the section and browse the subsection.

**Section Number**

Many states codify their laws by giving each statute section a unique number, which may include decimals, colons, or dashes. Following are examples of citations that use a unique section number:

<table>
<thead>
<tr>
<th>To retrieve:</th>
<th>Enter the query: (Terms and Connectors)</th>
<th>Enter the query*: (Fields Template)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mich Comp. Laws § 433.354</td>
<td>ci(433.354)</td>
<td>433.354</td>
</tr>
<tr>
<td>N.J. Stat. § 52:9a-1</td>
<td>ci(52:9a-1)</td>
<td>52:9a-1</td>
</tr>
</tbody>
</table>

* In the Fields Template, type the query in the Citation text box.

**Code Abbreviation and Section Number**

Some states codify their laws under specific codes like the Civil Code or Government Code. Each code name has a code abbreviation, which can be found on the Code Abbreviation card included with the documentation sent with the states' libraries.
The following list provides some examples:

<table>
<thead>
<tr>
<th>To retrieve</th>
<th>Enter the query: (Terms and Connectors)</th>
<th>Enter the query: (Fields Template)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cal. Gov’t Code § 423</td>
<td>ci(govt +5 423)</td>
<td>govt 423</td>
</tr>
<tr>
<td>La. Rev. Stat. § 49:159</td>
<td>ci(r.s. +5 49:159)</td>
<td>r.s. 49:159</td>
</tr>
</tbody>
</table>

* In the Fields Template, type the query in the Citation text box. These queries use the default /p connector.

Court Rule Abbreviation and Rule Number
The USCA and several state statutes books include court rules. A separate rules book may also be included with your state statutes library. Rule abbreviations can be found with the documentation sent with your library.

For example, to retrieve Rule 20 of the Rules for the Third Circuit Court of Appeals, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(cta3 +5 20).</td>
<td>In the Citation text box, type cta3 20.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

To retrieve DR 2-108 of the New York Code of Professional Responsibility, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(cpr +5 2-108).</td>
<td>In the Citation text box, type cpr 2-108.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

When You Know the Name
When you know the name of a USCA section or state statute section or court rule, you can retrieve the section or rule by restricting your search to the headings field (he). The headings field is also useful if you are not sure of the exact name but you want to exclude sections that only mention your subject matter.
To retrieve California statutes discussing the manipulation of the price of securities, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the <strong>Headings</strong> text box, type</td>
</tr>
<tr>
<td><code>security &amp; manipulat! &amp; price.</code></td>
<td><code>security &amp; manipulat! &amp; price.</code></td>
</tr>
</tbody>
</table>

Because the headings field contains the citation, prelim and caption fields, use the `&` connector to retrieve documents with terms in any of these fields. For example, to find the canon in the Texas Code of Judicial Conduct regarding a judge’s involvement in political activity, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the <strong>Headings</strong> text box, type</td>
</tr>
<tr>
<td><code>cjc &amp; politic!</code></td>
<td><code>cjc &amp; politic!</code></td>
</tr>
</tbody>
</table>

To retrieve state statutes titled *State Bird*, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query <code>(&quot;state bird&quot;)</code></td>
<td>In the <strong>Headings</strong> text box, type</td>
</tr>
<tr>
<td><code>&quot;state bird&quot;</code></td>
<td><code>&quot;state bird&quot;</code></td>
</tr>
</tbody>
</table>

Phrase searching should be used only when you are certain the phrase will not appear in other ways. For example, the phrase *jury trial* could also appear as *trial by jury*. To retrieve statutes with these terms in their titles, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the <strong>Headings</strong> text box, type</td>
</tr>
<tr>
<td><code>jury /3 trial</code></td>
<td><code>jury /3 trial</code></td>
</tr>
</tbody>
</table>

When You Know the Title, Part, Article, Chapter, or Subchapter Number
If you want to retrieve all of the sections in a title or part thereof, restrict your search to the prelim field (`pr`).
For example, to retrieve all sections of Title 7, Chapter 2 of USCA or Title 20, Chapter 6 of the Arizona Revised Statutes Annotated, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Prelim text box, type “title 7” “chapter 2”.</td>
</tr>
<tr>
<td>pr(“title 7” &amp; “chapter 2”).</td>
<td></td>
</tr>
<tr>
<td>Type the query</td>
<td>In the Prelim text box, type “title 20” “chapter 6”.</td>
</tr>
<tr>
<td>pr(“title 20” &amp; “chapter 6”).</td>
<td></td>
</tr>
</tbody>
</table>

* These queries use the default /p connector.

**Note** If the number is in Roman numerals, use Roman numerals.

You can also combine the name of a specific code with a subdivision number. For example, to retrieve Article 5 of the California Government Code, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Prelim text box, type “article 5” government.</td>
</tr>
<tr>
<td>pr(“article 5” &amp; government).</td>
<td></td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

**When You Know the Public or Session Law Number**

When you have a public or session law number and you want to know which statute sections were promulgated, amended, or repealed by that law, restrict your search to the credit field (cr).

For example, to find the laws affected by United States Public Law 102-497, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Credit text box, type 102-497.</td>
</tr>
<tr>
<td>cr(102-497)</td>
<td></td>
</tr>
</tbody>
</table>

Although each state numbers its session laws differently, most states number them either by year, by chapter and section number, or by public act and section number. Begin your search by using the /5 connector between the numbers. Some state statutes may require a larger connector like the /6 or /8 connector.

**Using the Statutes Index**

The index is available in many statutes libraries. You can use the index to find the citation of a statute when you know some substantive information about the statute, such as its subject matter.
When You Know the Subject Name

To browse the index for a particular subject, complete the following steps:

1. From the Library, select the Index book and click Retrieve Doc.
2. Type the word contents in the Retrieve Document dialog box and click OK.
3. Double-click the first letter of the category you are researching. For example, to research foreign banking, double-click F.
4. Scroll through the index until you reach the entry you want. Several entries beginning with the word Foreign are displayed.
5. Double-click the entry you want to view, such as Foreign Banking Corporation. The index page for Foreign Banking Corporation is displayed. This page lists relevant statute sections.
6. To go to a statute section from the index page, double-click the section.

When You Do Not Know the Subject Name

When you know the subject matter that you want to research but not the specific subject name, complete the following steps:

1. Select the Index book in the Library and click Search.
2. Enter a query restricted to the citation field. For example, to retrieve the index page for abstracts of title, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(abstract! /5 title).</td>
<td>In the Citation text box, type abstract! title.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

3. Click Search.
4. The index page for abstracts of title is displayed. Browse the search result to locate specific references.
5. To jump to a statute section, double-click the section.

Searching Session Laws

Some statutes libraries contain session law books. These books are added to statutes libraries to provide access to recent legislation that may amend or repeal an existing statute or enact a new statute. When a session law book is available, you should search it in addition to your statutes books.

This section explains how to retrieve session laws.

When You Know the Bill Number

1. Select a session laws book from the Library and click Search.
2. Enter a query that restricts your search to the citation field (ci). For example, to retrieve Senate Bill number 14-A, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(s.b. +5 14-a).</td>
<td>In the Citation text box, type s.b. 14-a.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

3. Click **Search**.

Below are abbreviations for documents found in some session laws books:

<table>
<thead>
<tr>
<th>Document</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Senate Bill</td>
<td>s.b.</td>
</tr>
<tr>
<td>House Bill</td>
<td>h.b.</td>
</tr>
<tr>
<td>Senate Joint Resolution</td>
<td>s.j.r.</td>
</tr>
<tr>
<td>House Joint Resolution</td>
<td>h.j.r.</td>
</tr>
<tr>
<td>Substitute House Bill</td>
<td>s.h.b.</td>
</tr>
<tr>
<td>Substitute Senate Bill</td>
<td>s.s.b.</td>
</tr>
<tr>
<td>Initiative Measures</td>
<td>i.m.</td>
</tr>
<tr>
<td>Chapter</td>
<td>ch</td>
</tr>
</tbody>
</table>

When You Know the Chapter, Act, or Westlaw Number
1. Select a session law book from the Library and click **Search**.
2. Enter a query that restricts your search to the citation field (ci). For example, to retrieve Chapter 95-136 of the Florida session laws, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(ch +5 95-136).</td>
<td>In the Citation text box, type ch 95-136.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

3. Click **Search**.

When You Want to Determine Whether a Specific Statute Section Has Been Amended or Repealed
1. Select a session law book from the Library and click **Search**.
2. Enter a query that restricts your search to the citation field (ci). For example, to retrieve session laws affecting Florida Statutes § 755.089, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query <code>ci(755.089)</code></td>
<td>In the Citation text box, type 755.089.</td>
</tr>
</tbody>
</table>

3. Click Search.

**When You Want to Retrieve a Newly Enacted Statute Section and You Do Not Know the Session Law Number**

1. Select a session law book from the Library and click Search.

2. Enter a descriptive word search. For example, to retrieve the session law enacting statute sections relating to protecting consumers from unfair prices during a state of emergency, enter one of the following queries:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query <code>emergency /p unfair or unconscionable /5 price or cost.</code></td>
<td>In the All Fields text box, type emergency /p unfair or unconscionable /5 price or cost.</td>
</tr>
</tbody>
</table>

3. Click Search.

**Using Field Restrictions**

You can use the following field restrictions in all session law books. By using these field restrictions, you can limit your search to the portion of a session law with the most pertinent information; the entire document, however, is retrieved for viewing.

<table>
<thead>
<tr>
<th>Field</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headings</td>
<td>he</td>
<td>Citation, prelim, and caption</td>
</tr>
<tr>
<td>Citation</td>
<td>ci</td>
<td>Unique references to documents</td>
</tr>
<tr>
<td>Prelim</td>
<td>pr</td>
<td>Headings preceding caption</td>
</tr>
<tr>
<td>Caption</td>
<td>ca</td>
<td>Chapter, bill or resolution number, topic</td>
</tr>
<tr>
<td>Summary</td>
<td>su</td>
<td>Summary of document</td>
</tr>
<tr>
<td>Text</td>
<td>te</td>
<td>Text of document</td>
</tr>
<tr>
<td>Date</td>
<td>da</td>
<td>Approval/effective/operative dates</td>
</tr>
</tbody>
</table>

**Searching Court Orders**

Because court rules may be amended, updating them is as vital to your research as updating case law and statutes. You can determine whether you have current information by searching your court orders and session law books.
Searching Court Orders to Update Court Rules
To update a rule, search for the rule abbreviation and number in the citation field (ci). You can find the rule abbreviation on the Rule Abbreviation card you received with the disc containing your court rules book.

Complete the following steps to update a court rule using the court orders book:

1. From the Library, select the court orders book and click Search.
2. Enter a citation field search using your preferred search method.
   
   **Note**  For example, to update Rule 1 of the Uniform Local Rules of the United States District Courts of Louisiana, search the Louisiana Court Orders book using one of the following search methods:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query (ci(\text{usdct} +5 1)).</td>
<td>In the Citation text box, type usdct 1.</td>
</tr>
</tbody>
</table>

   * This query uses the default /p connector.

   **Note**  Because court rules may be amended by legislative enactments as well as by judicial orders, you may also want to search your state’s session law book.

Searching Court Orders to Retrieve Newly Adopted Rules
To retrieve orders adopting new rules, use a descriptive word search.

Complete the following steps to search your court orders book to retrieve new rules:

1. From the Library, select the court orders book and click Search.
2. Enter a query using descriptive words.

For example, to retrieve new Louisiana rules regarding filing delinquency pleadings in juvenile court, search the Louisiana Court Orders book using one of the following search methods:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query (\text{fil*** /s pleading /s delinquent!} /p \text{juvenile}).</td>
<td>In the All Fields text box, type fi*** /s pleading /s delinquent! /p juvenile.</td>
</tr>
</tbody>
</table>

Updating Statutes Using Westlaw Legislative Service Databases
Because laws are approved throughout the legislative session, search for your state’s most recent session laws in your state’s legislative service database on Westlaw (XX-LEGIS, where XX is the state’s two-letter postal abbreviation). To update sections from the United States Code Annotated, search the United States Public Laws database (US-PL).

If your statute or session law book has a related session law update book, use the update book. You can search session law update books using the same methods that you use in session law books on CD-ROM.

Complete the following steps to update your state or USCA statute using a legislative service database. A Westlaw subscription is necessary to access the database, and Westlaw charges apply.
1. Choose **Search Database** from the Westlaw menu.

   **Note** If you are not already connected to Westlaw, the Westlaw Sign-On page is displayed. Type your Westlaw password in the **Westlaw password** text box. For security purposes, your password is not displayed as you type it. Type a client identifier in the **Client ID** text box.

![Figure 9-1. Welcome to Westlaw screen](image)

2. Type the database identifier, e.g., `or-legis`, in the **Search for a database** text box and click **Go**.

3. After you complete your search, display a result list so you can quickly see if the database contains any new material not included in your CD-ROM book.

   **Note** To disconnect from Westlaw, click **Sign Off** at the top of any Westlaw page.

**Updating Court Rules Using Court Orders Databases**

To update state court rules on Westlaw, search for orders in the state court orders databases (XX-ORDERS, where XX is the state's two-letter postal abbreviation). To update federal rules contained in the **United States Code Annotated**, search the Federal Orders database (US-ORDERS).

   **Note** If your court orders book has a related court orders update book, use the update book. You can search court orders update books using the same methods that you use in court orders books on CD-ROM.
10 Searching Digest Books

Overview
This chapter explains the following topics:

• how searching in a digest book differs from a case law book
• accessing the topic and key number outline
• jumping from the topic and key number list to a digest paragraph
• jumping from a case headnote (digest paragraph) to the topic and key number outline
• finding all topic and key numbers for a particular case
• retrieving statutes by limiting your search to the headnote field
• finding court and publication abbreviations for a particular jurisdiction

Using Digest Books
Digests are especially useful when you are searching for a specific legal concept. Each digest paragraph contains a summary of a single point of law, and with CD-ROM editions of West’s digests you can easily search and browse a large number of digest paragraphs on one or two discs. For example, if you are researching situations that may warrant postponement of notice and hearing required by due process, West’s digests are a good place to begin your search. If you are searching for highly specific facts or parties, e.g., a due process issue involving Monsanto Company and the Tucker Act, begin your research using case law books.

Digest books combine the paragraphs from many cases and organize them by topic and key number. CD-ROM editions of West’s digests contain digest paragraphs for state and federal law, the complete topic and key number classification analysis, and Jump markers that link digest paragraphs to the full text of opinions and cited statutes.

Each CD-ROM edition of West’s digests contains the complete West Digest System topic and key number outline. This detailed outline of the law is organized in a logical hierarchy and is easy to browse using the Jump feature.

Using digest books, you can access the topic and key number outline of the law in three ways:

• using the outline of the law
• using the topic list
• jumping from a case digest headnote
Using the Outline of the Law
Topics are divided into seven broad areas of law:

- persons
- property
- contracts
- torts
- crimes
- remedies
- government

To view the outline of the law from the Library, complete one of the following steps:

- Click Doc List, then double-click Outline of the Law.
- Or, select Outline of the Law and then click View Doc.

Use the Jump feature to view the topics included in a general category, for example, Persons. Then, to view key numbers classified under topic 78, Civil Rights, click the Jump marker preceding the topic number.

USING THE TOPIC LIST
The topic list arranges digest topics alphabetically.

To view the Topic List, complete one of the following steps:

- Double-click Topic List from a digest paragraph.
- Or, select Topic List and then click View Doc.

You can use the alphabet at the beginning of the list to go to a specific part of the list. For example, to go to the topic Civil Rights, click the Jump marker for the letter C, then scroll down to the topic. Use the Jump feature to view successive levels of the outline and to go to key numbers classified under the topic.

USING COURT AND PUBLICATION ABBREVIATIONS
You may want to limit your search to a particular court or publication. For example, to retrieve digest paragraphs from just the Supreme Court of California, add co(cal.) to your query.

In some instances, you may not know the court or publication abbreviation. To view a list of abbreviations for your jurisdiction, follow these steps:

1. Select the digest book from the Library and click Doc List.
2. Double-click Abbreviations of Courts.
Searching a Digest Book

USING DESCRIPTIVE WORDS

Digest documents contain digest paragraphs classified by a topic and key number. To search for terms within a digest paragraph, use the /p or a more restrictive connector between your search terms. For example, to search for cases discussing long-arm jurisdiction over foreign corporations, use one of the following:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>long-arm /p jurisdiction /p corporation</td>
<td>In the All Fields text box, type long-arm jurisdiction corporation.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

Your search retrieves digest paragraphs containing the terms long-arm, jurisdiction and corporation.

Retrieving a Document with a Topic and Key Number

You can retrieve documents with either a complete topic and key number, or with only part of the number.

Using a Complete Topic and Key Number

Suppose you are researching a probable cause issue under the topic Arrest, and you are searching for digest paragraphs classified under 35k63.4(5), Nature of offense: felony or misdemeanor. To retrieve headnotes classified under a specific topic and key number, use the Retrieve Document feature in the digest book:

2. Click Retrieve Doc.
3. Type the topic and key number, e.g., 35k63.4(5).
4. Click OK.

Using a Partial Topic and Key Number

When you know a partial topic and key number, for example, 35k63, restrict your search to the topic field, following the steps corresponding to your search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>to(35k63)</td>
<td>In the Topic text box, type 35k63.</td>
</tr>
</tbody>
</table>
USING FIELD RESTRICTIONS

You can use the following field restrictions in all digest books. By using these field restrictions, you can limit your search to the portion of a digest paragraph with the most pertinent information; the entire digest document, however, is retrieved for viewing. The following table shows an example of a digest paragraph and its fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>ke</td>
<td>Top line of classification hierarchy and key line</td>
</tr>
<tr>
<td>Digest</td>
<td>di</td>
<td>Topic and headnote</td>
</tr>
<tr>
<td>Topic</td>
<td>to</td>
<td>Classification hierarchy and key number line</td>
</tr>
<tr>
<td>Headnote</td>
<td>he</td>
<td>Text of headnote</td>
</tr>
<tr>
<td>Court</td>
<td>co</td>
<td>Court and year</td>
</tr>
<tr>
<td>Year</td>
<td>ye</td>
<td>Year</td>
</tr>
<tr>
<td>Title</td>
<td>ti</td>
<td>Case title</td>
</tr>
<tr>
<td>Citation</td>
<td>ci</td>
<td>Case citation</td>
</tr>
</tbody>
</table>

Using the Headnote Field

The headnote field contains a summary of a particular point of law discussed in a case. When you are searching for a statute, limit your search to the headnote field so that you don’t retrieve documents with irrelevant numbers. For example, to retrieve 35 Colo. Stat. Ann. § 106, use one of the following methods:

Terms and Connectors | Fields Template*               
---------------------|--------------------------------|
Type the query he(35 +5 106). | In the Headnote text box, type 35 106. |

Finding All Digest Paragraphs in a Case

To retrieve all digest paragraphs in a particular case, use the citation or title field. For example, to retrieve all digest paragraphs from People v. Barros, 835 P.2d 587, you can restrict your search to either field as described in the following examples:

Use this query format to restrict your search to the citation field:

Terms and Connectors | Fields Template*               
---------------------|--------------------------------|
Type the query cl(835 +5 587). | In the Citation text box, type 835 587. |

* This query uses the default /p connector.
Use this query format to restrict your search to the title field:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query <code>ti(barros /p people)</code></td>
<td>In the Title text box, type barros people.</td>
</tr>
</tbody>
</table>

**Combining Descriptive Terms with a Topic Field Search**

The topic field (to) in digest books is similar to the topic field in case law books, and contains the classification hierarchy and key number line. Use a topic field search when you want to search for all digest paragraphs under a particular topic. For example, to retrieve digest paragraphs classified under Topic 35, Arrest, which include descriptive terms about arrest and probable or reasonable cause, enter queries like the following:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query <code>to(35) /3 arrest! /p probable or reasonable /5 cause)</code></td>
<td>In the Topic text box, type 35. In the All Fields text box, type arrest! probable or reasonable cause.</td>
</tr>
</tbody>
</table>
11 Searching Administrative Law Books

Overview
This chapter explains the following topics:

• researching an administrative law issue
• finding materials in Scope and contents
• searching administrative law book fields
• using Westlaw to update administrative rules and regulations

Using Administrative Code Books
Federal and state administrative agencies promulgate their own rules and regulations in response to daily legal situations involving highly complex issues that neither legislatures nor courts can predict, e.g., importation of grapes from Australia.

Legal research often involves determining how regulations implement specific statutory provisions and how court opinions clarify the meaning of regulations or rules on the validity of administrative actions.

The West CD-ROM libraries include administrative material from the Code of Federal Regulations and the administrative codes of several states.

In administrative code books, regulations of various agencies are compiled in titles, chapters and sections that are usually organized by subject matter, e.g., Agriculture. Administrative code books contain the following two sources of background information: contents and scope.

Contents
Contents lists the titles and chapters in a particular book. To retrieve the table of contents for an administrative code book, use the Retrieve Document feature.

1. Select an administrative code book in the Library window.
2. Click Retrieve Doc at the bottom of the window.
3. Type contents in the Retrieve Document dialog box.
4. Click OK.

The table of contents for the administrative code book is displayed.

Scope
Scope lists the fields in a particular book. Scope may also contain coverage dates and citation format examples. To access Scope, complete the following steps:

1. Select an administrative code book in the Library window.
2. Click Retrieve Doc at the bottom of the window.
3. Type **scope** in the Retrieve Document dialog box.
4. Click **OK**.

**Researching Administrative Rules and Regulations**

Assume you represent a client importing fruits and vegetables. You need to know and keep up-to-date on United States Department of Agriculture regulations affecting fruits and vegetables. You will need to check the *Federal Register* and the *Code of Federal Regulations* (CFR)

Agency regulations are published chronologically in the *Federal Register*. The same regulations are then published, arranged by agency and subject, in the *Code of Federal Regulations*. The regulations are codified in 50 titles similar to titles in the *United States Code Annotated*. Within each title, regulations are arranged by agency. The titles are divided into chapters and the chapters are divided into parts.

**When You Know the Citation of a Regulation**

To retrieve a specific regulation when you know its citation, complete the following steps:

1. Select the book, e.g., *Code of Federal Regulations, Titles 1-26*, that contains the regulation you want to retrieve from the Library.
2. Click **Search** at the bottom of the window.
3. To retrieve, for example, 7 C.F.R § 319.56-2h, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(7 +5 319.56-2h).</td>
<td>In the Citation text box, type 7 319.56-2h.</td>
</tr>
</tbody>
</table>

* This query uses the default /p connector.

4. Click **Search**.

**When You Know the Name of a Regulation**

To retrieve a specific regulation when you know its name or its subject matter, restrict your search to the headings field (he) and complete the following steps:

1. From the Library, select the book that contains the regulation you want to retrieve, e.g., *Code of Federal Regulations, Titles 1-26*.
2. Click **Search** at the bottom of the window.
3. To retrieve, for example, regulations involving the quarantine of grapes or other fruit, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query he(grapes or fruit &amp; quarantin!).</td>
<td>In the Headings text box, type grapes or fruit &amp; quarantin!.</td>
</tr>
</tbody>
</table>

4. Click **Search**.
Researching Administrative Decisions

More than 30 agencies publish decisions and rulings as part of their quasi-judicial function. The form of these decisions is similar to that of court decisions.

When You Know the Citation of a Decision

To retrieve a specific decision when you know its citation, complete the following steps:

1. From the Library, select the book that contains the decision you want to retrieve, e.g., Minnesota Workers’ Compensation Decisions.
2. Click Search at the bottom of the window.
3. To retrieve, for example, 48 W.C.D. 251, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ci(48 +5 251).</td>
<td>In the Citation text box, type 48 +5 251.</td>
</tr>
</tbody>
</table>

4. Click Search.

When You Know the Title of a Decision

To retrieve a specific decision when you know its title, or an adverse party involved in the decision, complete the following steps:

1. From the Library, select the book that contains the decision you want to retrieve, e.g., Washington Environmental Law Decisions.
2. Click Search at the bottom of the window.
3. To retrieve, for example, Steelhammer Salmon Farms v. Washington, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ti(steelhammer /s washington).</td>
<td>In the Title text box, type steelhammer /s washington.</td>
</tr>
</tbody>
</table>

4. Click Search.

Using Other Field Restrictions

You can use the following field restrictions in administrative law books. By using these field restrictions, you can limit your search to the portion of an administrative law document with the most pertinent information; the entire document, however, is retrieved for viewing.
ADMINISTRATIVE CODE FIELDS

<table>
<thead>
<tr>
<th>Field</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citation</td>
<td>ci</td>
<td>Unique references to sections</td>
</tr>
<tr>
<td>Caption</td>
<td>ca</td>
<td>Section number and heading</td>
</tr>
<tr>
<td>Prelim</td>
<td>pr</td>
<td>Headings preceding caption</td>
</tr>
<tr>
<td>Heading</td>
<td>he</td>
<td>Caption, citation and prelim</td>
</tr>
<tr>
<td>Text</td>
<td>te</td>
<td>Text of the document</td>
</tr>
<tr>
<td>Note</td>
<td>no</td>
<td>Editorial notes and effective date notes</td>
</tr>
<tr>
<td>Credit</td>
<td>cr</td>
<td>Statutory credits of Federal Register source</td>
</tr>
</tbody>
</table>

Using the Note Field

Use the note field (no) to find information that clarifies a rule or regulation.

1. From the Library, select the book that contains the decision you want to retrieve, e.g., Code of Federal Regulations.
2. Click Search at the bottom of the window.
3. To limit your search to the section of the CFR that explains the difference between the terms work-day and man-day, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the Note text box, type</td>
</tr>
<tr>
<td>no(work-day /p man-day)</td>
<td>work-day man-day.</td>
</tr>
</tbody>
</table>

4. Click Search.

Using the Credit Field

When you know the citation of a source Federal Register document, use the credit field (cr).

1. From the Library, select the book that contains the decision you want to retrieve, e.g., Code of Federal Regulations.
2. Click Search at the bottom of the window.
3. To verify that the rule affecting the quarantine of grapes, first published in 59 Fed. Reg. 67609, is codified at 7 C.F.R. § 319.56, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query</td>
<td>In the All Fields text box, type</td>
</tr>
<tr>
<td>cr(59 +5 67609) &amp; quarantin! &amp; grapes</td>
<td>quarantin! &amp; grapes</td>
</tr>
<tr>
<td></td>
<td>Then in the Credit text box, type</td>
</tr>
<tr>
<td></td>
<td>(59 +5 67609)</td>
</tr>
</tbody>
</table>

* Different fields are automatically connected with the & connector.

4. Click Search.
Using the Prelim Field
To retrieve all of the sections in a specific title or any of its parts, restrict your search to the prelim field (pr).

1. Select the book that contains the decision you want to retrieve from the Library, e.g., Code of Federal Regulations.
2. Click Search at the bottom of the window.
3. To retrieve all sections of CFR Title 7, Part 246, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query pr(“title 7” &amp; “part 246”).</td>
<td>In the Prelim text box, type “title 7” “part 246”.</td>
</tr>
</tbody>
</table>

4. Click Search.

Using the Caption Field
If you want to retrieve a specific section, restrict your search to the caption field (ca).

1. Select the book that contains the decision you want to retrieve from the Library, e.g., Code of Federal Regulations.
2. Click Search at the bottom of the window.
3. To retrieve CFR sections dealing with supplemental foods, follow the steps corresponding to your preferred search method:

<table>
<thead>
<tr>
<th>Terms and Connectors</th>
<th>Fields Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type the query ca(supplement! /p food)</td>
<td>In the Caption text box, type supplement! food.</td>
</tr>
</tbody>
</table>

4. Click Search.
Searching Administrative Law Books

Administrative Decision Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citation</td>
<td>ci</td>
<td>Unique references for citing to specific documents</td>
</tr>
<tr>
<td>Title</td>
<td>ti</td>
<td>Names of adverse parties to a decision</td>
</tr>
<tr>
<td>Prelim</td>
<td>pr</td>
<td>Docket numbers and other information</td>
</tr>
<tr>
<td>Date</td>
<td>da</td>
<td>Date of decision</td>
</tr>
<tr>
<td>Attorney</td>
<td>at</td>
<td>Names of counsel</td>
</tr>
<tr>
<td>Text</td>
<td>op</td>
<td>Document text</td>
</tr>
<tr>
<td>Author</td>
<td>au</td>
<td>Author of principal opinion</td>
</tr>
<tr>
<td>Source</td>
<td>so</td>
<td>Administrative body that issued decision</td>
</tr>
</tbody>
</table>

Updating Administrative Materials Using Westlaw

To update a section from the Code of Federal Regulations, access the Federal Register database (FR) on Westlaw and search for the CFR title and part number in the prelim field (pr). Add the CFR section number after the prelim field restriction using the & connector.

1. Choose Search Database from the Westlaw menu.
2. Once you are connected to Westlaw, the Welcome to Westlaw screen is displayed.

![Welcome to Westlaw screen]

3. Type the database identifier fr in the Search for a database text box, then click Go.
4. To update 7 C.F.R. § 319.56-2h, using the Terms and Connectors search method, type the query pr(7 +s 319) & 319.56!.
5. Click Search.
12 Changing Preferences

Overview
This chapter explains how you can modify Premise at your workstation to meet your specific needs.

Changing Preferences
Choose Setup, Preferences from the File menu to customize your Premise user interface options.

The Preferences dialog box is displayed.

Figure 12-1. Preferences dialog box

SCREEN DISPLAY SETTINGS
The following screen display options are available in the upper-left corner of the Preferences dialog box.

- **Project Time Summary.** Select this option to display a dialog box telling you the amount of time spent on a project when you close it. This is the default setting.
- **Maximize on Open.** Select this option to maximize windows when they are opened. This is the default setting.
- **Show Balloon Help.** Select this option to turn on balloon help where available. This is the default setting.
- **Display Inline Images.** Select this option to display images in context in your Premise books.
The options for Workstation, Search, and Client Validation appear in a dialog box when you click the corresponding button. The screen display and text display settings are displayed automatically in the dialog box when you choose the Preferences command.

The Preferences options are described in the following table.

<table>
<thead>
<tr>
<th>Category</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen and Text Display Settings</td>
<td>• Display a summary of time spent on the current project when you close the project</td>
</tr>
<tr>
<td></td>
<td>• Maximize each new window</td>
</tr>
<tr>
<td></td>
<td>• Show balloon help</td>
</tr>
<tr>
<td></td>
<td>• Display inline images</td>
</tr>
<tr>
<td></td>
<td>• Access Westlaw</td>
</tr>
<tr>
<td></td>
<td>• Set display settings for normal text, highlighted terms, hypertext references, non-proportional text, star paging and best sections (e.g., font, size, color)</td>
</tr>
<tr>
<td>Workstation</td>
<td>• First window displayed when you start Premise</td>
</tr>
<tr>
<td></td>
<td>• Window displayed upon opening a new book</td>
</tr>
<tr>
<td>Search</td>
<td>• Browsing display in documents retrieved by a query</td>
</tr>
<tr>
<td>Client Validation</td>
<td>• West-supplied client validation</td>
</tr>
</tbody>
</table>

**CHANGING TEXT DISPLAY SETTINGS**

Your text display settings can be changed in the Preferences dialog box.

**TEXT DISPLAY SETTINGS**

You can change the attributes for six kinds of text in the Text Type list box:

- Normal text (the text displayed in all of the Premise screens)
- Highlighted terms (the search terms in your search results)
- Hypertext references (referenced information, such as cited cases, that you can jump directly to)
- Nonproportional text (tabular information)
- Star paging (specific pages from the print publication)
- Best section (best portion of a Natural Language search)
Complete the following steps to change text display settings:

1. Select the type of text you want to change in the Text Type list box.

2. To change the font, select the font from the Font list box.
   - **Note** The font selected for normal text will also be used for the highlighted terms, hypertext references, star paging and best features.

3. To change the type size, select the type size you want in the Size list box.
   - **Note** The size selected for normal text will also be used for the highlighted terms, hypertext references, star paging and best features.

4. To change the color of the text selected in the Text Type list box, select the color you want to use from the Color drop-down list.

5. To display the selected text type with boldface, underlining or italics, click the appropriate check boxes under Attributes.

6. Repeat steps 1 through 5 for each type of text that you want to change.

7. As you make changes, an example of the text with the current attribute settings is displayed in the Sample box. After adjusting your display settings attributes in the Preferences dialog box, click OK to save the new settings.

**CHANGING WORKSTATION OPTIONS**

You can view the Workstation Preferences dialog box by clicking Workstation in the Preferences dialog box. The Workstation Preferences dialog box is displayed.

The Workstation Preferences dialog box allows you to select the first window displayed when you start Premise and the first dialog box displayed when you open a new book.

![Workstation Preferences dialog box](image-url)
First Window
To change the first window displayed when you start Premise, select one of the four listed options:

- **Instruction (Welcome) Window.** This window gives you options to start a new research project, open an existing project or install a new book. **Instruction Window** is the default setting.
- **Start a New Project.** Each time you start Premise, a new research project automatically starts and the Library window is displayed.
- **Open an Existing Project.** Each time you start Premise, the Open Project dialog box is displayed. You can select one of your saved research projects and resume your research.
- **Search Book(s).** You can select books that you regularly search and automatically go to the Search dialog box for those books.

Upon Opening a New Book
To select the default activity when you open a new book, select one of the four listed options:

- **Search Book (Default).** The Search dialog box, in which you can enter a query, is displayed. **Search Book** is the default setting.
- **View Scope/First Page.** The first page of text in the book is displayed. For most West CD-ROM Libraries books, the first page is the Scope document.
- **View Document List.** The list of all documents contained in the book is displayed.
- **Retrieve Document.** The Retrieve Document dialog box is displayed, in which you can enter a specific citation and move directly to the case.

After you have chosen your Workstation Preferences, click **Done,** then click **OK** to save your settings.

**CHANGING SEARCH OPTIONS**
The Search Preferences dialog box allows you to select which page is displayed when browsing through your search results by search term.

You can view the Search Preferences dialog box by clicking **Search** in the Preferences dialog box. The Search Preferences dialog box is displayed.

![Search Preferences dialog box](image)

**Figure 12-3. Search Preferences dialog box**

To select which page is displayed when browsing by search term, select one of the listed options:

- **First Page (Default).** The first page of the next document is displayed, even though that page may not contain any search terms. **First Page** is the default setting.
- **First Term Page.** The first page containing a search term in the document is displayed. The first page of a document is displayed only if it contains search terms.
SETTING UP CLIENT VALIDATION

The Client Validation program keeps track of how much research was done for each client. You can use either the West-supplied Client Validation program or one that you customize.
13 Using the Toolbar

Overview
The Premise toolbar simplifies your research by giving you an easy way to use many of the commands that are available in the pull-down menus. This chapter explains how you can create your own toolbar; edit an existing toolbar; change the location of the toolbar on your screen; and choose to view text, icons or both in your toolbar.

Customizing the Toolbar
The Premise Default toolbar cannot be changed, but you can use it to create a new toolbar.

1. Choose Setup, Toolbars from the File menu. The Toolbar Setup dialog box displayed:

2. Click New to name the new toolbar.
3. Type the name of the new toolbar in the text box, then click OK.
4. Select the new toolbar, then click Edit.
The Customize Toolbar dialog box is displayed.

![Customize Toolbar dialog box](image)

Figure 13-2. Customize Toolbar dialog box

- Add a command to the toolbar by selecting it from the *Available toolbar buttons* list box and then clicking **Add**.
- Remove a command from the toolbar by selecting it from the *Current toolbar buttons* list box and then clicking **Remove**.
- Reorder the commands on the toolbar by clicking a command in the *Current toolbar buttons* list box and dragging it to a new position or click **Move Up** or **Move Down** to move the button to a new location on the toolbar.